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Upgrading the MG 9000

This document contains upgrade and downgrade information and
procedures for the MG 9000 cards and the MG 9000 Manager.

When to use this document

Use this document when it is necessary to upgrade the MG 9000
Manager and the MG 9000. Separate upgrade procedures are provided
in this document that fit different upgrade scenarios as noted below:

e downgrading the software in the MG 9000 Manager and MG 9000
* upgrading the MG 9000 Manger software to a maintenance release
e upgrading the MG 9000 cards individually

e upgrading the MG 9000 cards by card type

e upgrading all the MG 9000 cards

When upgrading the MG 9000 Manager and MG 9000 from SN06.x to
SNO08 or from SNO7 to SN08, use the MG 9000 upgrade procedures
presented in the Upgrading a Carrier Voice over IP Network,
NN10440-450.

Tools and utilities

The MG 9000 and the MG 9000 Manager software support software
upgrades and downgrades. Procedures in this document support these
activities. The MG 9000 and MG 9000 Manager support patching
through the network patch manager (NPM). Procedures for patching
the MG 9000 and the MG 9000 Manager are provided in Upgrading a
Carrier Voice over IP Network, NN10440-450.

The MG 9000 Manager provides a tool to upgrade the software in the
intelligent DCC, ITX, ITP, DS-512 (ABI), DS1, MTA, and xDSL cards. A
single card or multiple cards can be upgraded using this tool.

In addition, the software in the xDSL and MTA cards can be
downloaded into the cards using the Software Download tool available
from the xDSL and MTA Card Views in the MG 9000 Manager.

Upgrading the MG 9000
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Procedures for downloading software into the xDSL and MTA cards are
provided in this document.

MG 9000 Manager client system requirements

Recommended minimum configurations for the MG 9000 Manager
client are provided in the following table.

MG 9000 Manager client minimum configurations

Client platform Configuration

Windows client ¢ Windows NT 4.0 (SP5 or later), Windows 2000 (SP2 or later),

Solaris client e Solaris 7 or Solaris 8 with Sun recommended patches for

or Windows XP
e Pentium Il 1 GHz or higher
» display resolution of 1280 x 1024 with 256 colors
e 256 MB RAM
e 200 MB hard drive space
* 10BaseT/100BaseT Ethernet network connection
e Java Web Start (JWS) 1.4.2_05 and higher
If the Windows PC supports more Succession client applications

than just the MG 9000 Manager client application, the following
minimum configuration is required:

* Windows 2000 (SP2 or later), or Windows XP

e Pentium Il 2.5 GHz or higher

» display resolution of 1280 x 1024 with 256 colors

e 1 Ghz RAM

e 30 Gb hard drive space

* 10BaseT/100BaseT Ethernet network connection

e Java Runtime Environment (JRE) 1.4.1_02 and higher
e Java Web Start (JWS) 1.4.2_05 and higher

Java Runtime Environment (JRE) 1.4.1_02
e Ultra 5 400 MHz or higher
» display resolution of 1280 x 1024 with 256 colors
e 256 MB RAM
e 200 MB hard drive space
* 10BaseT/100BaseT Ethernet network connection

NN10048-461

('SN08 Standard 07.02 June 2005



Copyright © 2005, Nortel Networks 3 Nortel Networks Confidential

MG 9000 Manager client minimum configurations

Client platform Configuration

Windows or Third party software
Solaris client * Netscape 6.0 and higher or Internet Explorer 5.5, 6.0 and
higher

e Java Web Start (JWS) 1.4.2_05 and higher

Note: Access to some functions requires the use of SSH compatible client software
for access to secure telnet and ftp services (using SSH standard). SSH clients are
supplied bundled with some operating systems, but may need to be obtained
separately. Sources for SSH clients include, but are not limited to the following:

e PUTTY - freeware

e OpenSSH - freeware

e SSH Inc. - commercial

e Secure CRT - commercial

e WinSCP - freeware

Nortel Networks does not supply or recommend a particular supplier.

Applying software fixes
When it is necessary to apply software fixes, the following methods are
available:

* Maintenance Release upgrade process: refer to the procedure

Upgrading the MG 9000 Manager software to a maintenance
release on page 19

* Patching

— SNO08 patching of the MG 9000 Manager is handled as noted in
Patching MG 9000 Manager software on page 57

Upgrading the MG 9000
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Upgrading the MG 9000 Manager

The following procedures are included in this section:
e Configuring MG 9000 Manager client software on page 6

* Retrieving MG 9000 Manager software using Electronic Software
Delivery on page 12

e Upgrading the MG 9000 Manager software to a maintenance
release on page 19

¢ Downgrading the MG 9000 and MG 9000 Manager from SNOS8 to
SNO06.2 or SNO7 on page 32

e Patching MG 9000 Manager software on page 57

Upgrading the MG 9000
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Configuring MG 9000 Manager client software

When to use this procedure
Use these procedures for upgrading software on a PC client or Sun

client.

The following procedures are included in this section:

* Installing the MG 9000 Manager Sun client software

* Uninstalling the MG 9000 Manager Sun client software

e Installing the MG 9000 Manager Windows PC client software
* Removing an MG 9000 Manager JWS application from cache

Prerequisites
There are no prerequisites.

e
NN10048-461 (I)SNO8 Standard 07.02 June 2005
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Action

MG 9000 Manager client configuration
Installing the MG 9000 Manager Windows PC client software

At the Windows PC client

1 From a web browser, launch Succession OAM&P Applications
Launch Point page at:
http://<SN08 MG9KEM Midtier Server IP or hostname>. Click on
Application Launcher.

The Application Launch Point window appears containing one
link for SNO8. Click on the SN08 “MG9000 Element Manager”
link. The Application Launch Point window appears. Click on the”
MG9000 Element Manager” link. Enter the username and
password in the login when prompted.

Note: When starting the MG 9000 Manager from a Microsoft
Windows platform, Windows may ask for a Security Certificate
Approval. Windows does not display the Security Certificate
Approval window on top of all other open windows. It may
become necessary to iconify all open windows to see the
Security Certificate Approval window. The security settings in
the browser determine if the user will be asked for certificate
approval.

Upgrading the MG 9000
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Use the following figure and the information in the following table
to determine the next step.

Java™ Web Start could not be detected in this browser. Ensure
that Java™ Web Start is installed before you launch these
applications. Please see the for
installation details

If Java Web Start (JWS) Do

software

is already installed in the client step 8
machine

is not installed in the client step 3

machine, as evidenced by the
preceding message

Select the link “Java™ Web Start Install Guide” to visit “Client
Software Installation” page.

Visit “Java 2 Runtime Environment Install Guide” under
“Microsoft Windows” section for online documentation.

Visit “Java 2 Runtime Environment Software Download” under
“Microsoft Windows” section to download Java Runtime
Environment.

Save j2re-1_4_2_05-windows-i586-i.exe and execute the JRE
software.

Follow the instructions in JRE software to install JRE 1.4.2_05

The PC client is setup to launch MG 9000 Manager SNO7 client
applications.

This procedure is complete.

('SN08 Standard 07.02 June 2005
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Installing the MG 9000 Sun client software

At the client workstation

1

9

From a web browser, launch Succession OAM&P Applications
Launch Point page at:
http://<SN08 MG9KEM Midtier Server IP or hostname>. Click on
Application Launcher.

The Application Launch Point window appears with a link for
SNO8. Click on the SNO8 “MG9000 Element Manager” link.
Enter the username and password in the login when prompted.

Use the following figure and the information in the following table
to determine the next step.

Java™ Web Start could not be detected in this browser Ensure
that Java™ Web Startis installed before you launch these
applications. Please see the for
installation details

If Java Web Start (JWS) Do
version 1.4.2_05 software

is already installed in the client step 14
machine
is not installed in the client step 3

machine, as evidenced by the
preceding message

Select the link “Java™ Web Start Install Guide” to visit “Client
Software Installation” page.

Visit “Java 2 Runtime Environment Install Guide” under “Sun
Solaris” section for online documentation.

Visit “Java 2 Runtime Environment Software Download” under
“Sun Solaris” section to download Java Runtime Environment.

Save j2re-1_4_2_05-solaris-sparc.sh to your home directory.
Change execute permissions
$ chmod +x j2re-1_4 2 05-solaris-sparc.sh

Execute JRE, this will create a JRE subdirectory called
j2re1.4.2_05 in your home directory. Remember the path of this
directory as you will need this path later when configuring JWS.

$ ./ j2re-1_4 2 05-solaris-sparc.sh
Follow the instructions in JRE software to install JRE 1.4.2_05

Upgrading the MG 9000
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10

11

12

13
14

15

16

In your j2re1.4.2_05 subdirectory there is a zip file called
javaws-1_4_2_05-solaris-sparc-i.zip. Copy this zip file to your
home directory.

Install JWS by unzipping the zip file and executing “install.sh”.
$ unzip ./javaws-1_4_ 2 05-solaris-sparc-i.zip
$ ./install.sh

Accept the license agreement and enter the path to JRE from
step 8.

Follow the remaining online directions.

The Sun Solaris client is now setup to launch MG9KEM SNO08
client applications.

Exit the browser and launch the browser again for settings to
take effect.

This procedure is complete.

Removing an MG 9000 Manager JWS application from cache

At the MG 9000 Manager client PC

1

a A~ WODN

Access the Java Web Start Application Manager by selecting
Start->Programs->Java Web Start. The Java Web Start
Application Manager appears.

Select View->Downloaded Applications from the menu bar.
Select an MG 9000 Manager JWS application to be deleted.
Select Application->Remove Application from the menu bar.
This procedure is complete.

The following procedure is provided as an optional method for
accessing a JWS application on a Sun workstation.

Accessing JWS application on a Sun workstation

At the client workstation

1

Change directory to where the Java Web Start application is
installed and enter the following command

> c¢d <path/javaws>
To launch the Java Web Start application manager, type
> javaws &

Select View->Downloaded Applications from the menu bar.

('SN08 Standard 07.02 June 2005
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4 This procedure is complete.
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Retrieving MG 9000 Manager software using Electronic Software
Delivery

Purpose of this procedure

These procedures describe how to transfer MG 9000 Manager software
loads from Nortel Networks to a customer drop box using the Electronic
Software Delivery (ESD) method, and how to make the transferred
loads available for installation on the MG 9000 Manager.

When to use this procedure

Use this procedure after receiving electronic notification for MG 9000
Manager software loads.

Prerequisites

Your operating company must have an ESD agreement with Nortel
Networks. When the agreement was established, the operating
company furnished Nortel Networks with the location of an electronic
drop box and a user name and password pair for delivering software
loads. When Nortel Networks delivers a software load to the drop box,
an electronic mail notification is sent to the e-mail address specified by
the telephone operating company when the ESD agreement was
established.

Action

Retrieving MG 9000 Manager software using Electronic Software
Delivery

At the MG 9000 Manager server requiring software loads
1 Become the root user by typing

Note: If this is an N240 cluster (two-server) configuration,
perform the following step in the inactive node.

# su - root

2 Get the MG 9000 Manager ISO image file into the root directory
of the MG 9000 Manager server by performing the following
steps

a Change to the root directory by typing
# cd /

NN10048-461 (I)SNO8 Standard 07.02 June 2005
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b

Verify you are at the root directory by typing
# pwd

The system responds with the following

/

Use FTP to get the ISO file by typing

# ftp x.x.x.x

where
X.X.X.X is the IP address of the MG 9000 Manager
master server

Change directory to the iso files location.

Select the file transfer protocol type by typing

# binary

Get the MG 9000 Manager iso image file by typing
# get mg9kem 8 <version number>.iso

where
version_number is the version number of the iso file,
such as 501

g Quit the FTP activity by typing

# quit

Verify that the file exists on the MG 9000 Manager server in the

root directory by performing the following

a Change to the root directory by typing

# cd /

b List the contents of the directory containing files with .iso

extension by typing
# 1s -1 *.iso
An example system response

-rw-r--r—-- 1 root other 47945728 Jan 11 15:39
mg9kem_8_501.iso

Upgrading the MG 9000
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Mount the image by performing the following
a Enter the command line interface by typing

# cli
The system responds with the following

Command Line Interface

1 - View

2 - Configuration
3 - Other

X - exit

select -

Select option 3.
The system responds with the following

Other

1 - Log Rotation

2 - capt_files (Capture Various SSPFS
Files/Logs For Debugging Purposes)

3 - sun_explorer (Execute the Sun Explorer
Data Gathering Tool)

4 - mount_image (Mount A Generic Iso Image To
The SSPFS Unit)

5 - umount_image (Un-Mount A Generic Iso
Image From The SSPFS Unit)

6 - disp_sspfspatch (Display the patching
status of the SSPFS unit)

X - exit

select -

(N’SN08 Standard 07.02 June 2005
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Cc

cli command responses

Select option 4
The system responds with the following

=== Executing "mount_image"
Enter Full Path To ISO Image:

Enter the full path to the ISO image by typing
# /mg9kem 8 <version number>.iso

Example
# /mg9kem_8_501.iso

The system responds with the following

Is 1s very important for the user of this
command to know that if you mount an iso
image. It is a MUST that you umount an image
before removing the image file. If the file
is deleted while the 0S has it mounted, it can
be harmful to the runtime applications

on this unit

=== "mount_image" completed successfully

A response is printed to the terminal. Use following table to
determine if the command was successful.

Response

Meaning and action

Is is very important for the This response indicates success.
user of this command to know

that if you mount an iso image.

It is a MUST that you umount an

image before removing the

image file. If the file is

deleted while the 0S has it

mounted, it can be harmful to

the runtime applications on

this unit

Provided full path to ISO image Verify the location and name of the ISO

does not exist

ISO Image Already Mounted Perform step 6 to unmount the image.

image by entering
Is -1 /*.iso

Upgrading the MG 9000
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cli command responses

Response

Meaning and action

Error creating the
device location

ERROR MOUNTING <ESD_filename> This response indicates that either the

image This response indicates an operating
system error with the loopback file driver.
Retry the command, and if it fails a
second time, contact Nortel Networks
support personnel.

ISO 9660 file is corrupt, or the / tmpmnt/
directory has been deleted.

e

The contents of the ESD software file are available in
directory /tmpmnt/ .

To exit each menu level, type
# x

5 Access the MG 9000 Manager packages and copy them to a
permanent location.

a

List the contents of the tmpmnt directory by typing
# 1ls -1 /tmpmnt
The system responds with the following

total 93520

-r--r--r-- 1 root root 25888256 Dec 9 12:42
NTMGO9KM_8_501_0.PKG

-r--r--r—-- 1 root root 21303808 Dec 9 12:42
NTMGO9KS_8_501_0.PKG

-r--r--r-- 1 root root 690176 Dec 9 12:42
NTOMCLTR_8_501_0.PKG

Copy the packages in tmpmnt directory to a permanent
location by typing

# cp /tmpmnt/*.PKG /opt/nortel/

Verify the package files are on directory /opt/nortel by typing
# cd /opt/nortel

List the contents of all files with .PKG suffix by typing

# 1s -1 *PKG

NN10048-461 (I)SNO8 Standard 07.02 June 2005
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6

Unmount the MG 9000 Manager ISO image by performing the
following

a

d

Enter the command line interface by typing
# cli
The system responds with the following

Command Line Interface

1 - View

2 - Configuration
3 - Other

X - exilit

select -

Select option 3.
The system responds with the following

Other

1 - Log Rotation

2 - capt_files (Capture Various SSPFS
Files/Logs For Debugging Purposes)

3 - sun_explorer (Execute the Sun Explorer
Data Gathering Tool)

4 - mount_image (Mount A Generic Iso Image To
The SSPFS Unit)

5 - umount_image (Un-Mount A Generic Iso
Image From The SSPFS Unit)

6 - disp_sspfspatch (Display the patching
status of the SSPFS unit)

X - exit

select -
Select option 5.

The system responds with the following

== Executing "umount_image"
== "umount_image" completed successfully

To exit each menu level, type
X

3+

Upgrading the MG 9000
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7

e Verify the MG 9000 Manager packages no longer exist in the

tmpmnt directory by changing to the /tmpmnt directory and
listing the contents

# cd /tmpmnt

# 1s -1

The system responds with the following
total O

Change to the root directory by typing
# cd /

List the contents of the directory containing files with a .iso
extension by typing

# 1s -1 *.iso
Remove the EM ISO file by typing
# rm /mg9kem 8 <version_number>.iso

Example
# rm /mg9kem_8_501.iso

This procedure is complete.

(N’SN08 Standard 07.02 June 2005
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Upgrading the MG 9000 Manager software to a maintenance release

When to use this procedure

Use the following procedure when upgrading the MG 9000 Manager
software to a maintenance release (MR).

When a maintenance release is made available to the customer, data
on the MG 9000 Manager which is at the SNO8 format, must be moved
into the MR format to maintain provisioned data.

The MR process is different depending on whether you have a High
Availability (HA)-Cluster or non Cluster setup.

* non Cluster setup - a simplex configuration with a single N240
server or two T1400’s configured to run the MG 9000 Manager
software

* HA-Cluster setup - a duplex configuration with two N240 servers
that share one cluster IP address

Use the MR process that applies to your MG 9000 Manager setup.

Prerequisites
There are no prerequisites.

Action

i __________________________________}
Upgrading the MG 9000
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Upgrading MG 9000 Manager software to a maintenance release in
a non Cluster setup (simplex configuration)

At the MG 9000 Manager

1 Prior to proceeding with this MR upgrade procedure, perform a
backup of the entire Oracle database. Refer to “Performing a
data backup on a Sun server” in Upgrading a Carrier Voice over
IP Network, NN10440-450.

2 Upgrade the hardware, if necessary. Ensure the connection from
the MG 9000 Manager to the MG 9000 is up.

3 To stop the GUI clients, click on File->Exit from the GUI to exit.

4 Telnet into the server running the MG 9000 Manager mid-tier
application and log in as root at the servers during the MR
process.

5 Stop the mid-tier server by typing
# servstop MGY9KMIDTIER 08
Process information will be displayed

Shutting MG 9K Midtier Server down ...
Midtier shutdown complete

6 Stop the Performance Collector and Formatter (PCF) OM
collection application by typing

# servstop MGO9KOMC_08

Process information will be displayed

Shutting OM Collector down ...

OM Collector shutdown complete
7 Stop the master server by typing

# servstop MGY9KSERVER 08

Process information will be displayed

Shutting MG 9K Server down ...

Server shutdown complete

8 If required, upgrade to the MR Succession Solaris Platform
Foundation Software (SSPFS) Platform software, if any. Refer to
“Upgrading SSPFS Software” in Upgrading a Carrier Voice over
IP Network, NN10440-450. Back up the MG 9000 file system
and save all data in the /data/mg9kem/persistdata directory. This
includes the SSPFS load on the servers running the MG 9000
Manager master and mid-tier applications.

NN10048-461 (I)SNO8 Standard 07.02 June 2005
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9

10

Remove the old MG 9000 Manager server package by typing
> pkgrm NTmg9ks08

The following package is currently installed:

NTmg9ks08 Succession MG 9000 Manager Server
(sparc) NTMGOKS_08_11_0

Do you want to remove this package?

Install and start the MR release MG 9000 Manager server
application and initialize the database by performing the
following steps:

a Telnet into the server running the MG 9000 Manager server
application and log in as root.

b Use the following table to determine the next step.

If installing the master Do
server software from

CD-ROM step C

electronic software delivery (ESD)  step d

¢ Add in the MR server package from CD-ROM by typing

> pkgadd -4
/cdrom/cdrom0/<MG9K_MR server_ package_name>.
pkg

The following packages are available:

1 NTmg9ks08 Succession MG 9000 Manager Server
(sparc) NTMGOKS_08_44_0

Select package(s) you wish to process (or

‘all’ to process all packages).

(default: all) [?,??,qg]l:1

Go to step e.
d Add inthe MR server package from ESD by typing
> pkgadd -4
/data/loads/<MG9K_MR_server package_ name>.pk
g
The following packages are available:
1 NTmg9ks08 Succession MG 9000 Manager Server
(sparc) NTMGOKS_08_44_0
Select package(s) you wish to process (or

‘all’ to process all packages).
(default: all) [?,??,q9l:1

Upgrading the MG 9000
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e Change to the following directory
> /opt/nortel/mg9ksrv_08/bin

f Configure the MG 9000 Manager server by typing
> ./mg9kconfig.sh
The system responds with the following message:

Setup has detected configuration settings
from a previous installation.

R R IR R i b b S b S b b S b S b b i b S b b b b I b S S R S R b e b S b b b i b S

Setup Server As MASTER
Master Server IP Address 47 .xxx.xx.207
SESM IP Address : 47 .xxx.x%x.220
Security Authentication Host: 47.xxx.xx.220
Oracle IP Address 47 . XXX .XX.8
Image Server 47 . xxx.xx.207
Image Server User ID maint
SuperCore Gige Image Dlrectory /swd/mg9k
SuperCore IMA Image Directory: /swd/mg9k
SuperCore OC3 Image Dlrectory /swd/mg9k
ITP Image Directory /swd/mg9k
ITX Image Directory /swd/mg9k
ABI Image Directory /swd/mg9k
DS1 Image Directory /swd/mg9k

*****************************;**************

Is the above information correct?

Press the enter key to accept the default

(y/n)?

Default: [n]=>vy

1 Start the MR MG 9000 Manager server application by typing
> servstart MGY9KSERVER_ 08

12 Install and start the MR release mid-tier application by
performing the following steps:

a Telnetinto the server running the MG 9000 Manager mid-tier
application and log in as root on the MG 9000 mid-tier server.

b Remove the old mid-tier package by typing
> pkgrm NTmg9kmO08

The following packages are available:
1 NTmg9km08 Succession MG 9000 Manager
Midtier Server
(sparc) NTMGOKM_8 44 0
Do you want to remove this package? y

('SN08 Standard 07.02 June 2005
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¢ Use the following table to determine the next step.

If installing the mid-tier Do
server software from

CD-ROM step d

electronic software delivery (ESD) step e

d Add in the MR mid-tier package from the CD-ROM by typing

> pkgadd -4
/cdrom/cdrom0/<MG9K_MR midtier package_ name>
-Pkg

The following packages are available:
1 NTmg9km08 Succession MG 9000 Manager
Midtier Server
(sparc) NTMGOKM_8_44_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,g]l:1

Gotostepf

e Add in the MR mid-tier package from ESD by typing

> pkgadd -4
/data/loads/<MG9K_MR midtier package name>.p
kg

The following packages are available:
1 NTmg9km08 Succession MG 9000 Manager
Midtier Server
(sparc) NTMGOKM_8_44_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,g]l:1

f Change to the following directory

> /opt/nortel/mg9kmtr_ 08/bin

g Configure the mid-tier by typing

> ./mg9kconfig.sh

Setup has detected configuration settings
from a previous installation.

AR R b b b I b I b S i i b S i i i i i i i i b i i i b I b S i i i S S
Master Server IP Address : 47.142.84.210
Security Authentication Host : 47.142.84.211

ERE I R R S I b b b b S S b S b b S A b b S S S b S S S R S S b R S S I S S

Upgrading the MG 9000
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Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] => vy

h Start the MR mid-tier application by typing
> servstart MGI9KMIDTIER_ 07

13 Install and start the SNO8 MR OM collection application on the
server where the mid-tier application is running by performing
the following:

a Remove the old SNO8 OM collector package by typing
> pkgrm NTomclt08

The following packages are available:
1 NTomcltm08 Succession Operational
Measurement Collector

(sparc) NTOMCLTR_8_441_0
Do you want to remove this package? y

b Use the following table to determine the next step.

If installing the OM Collec- Do
tor software from

CD-ROM step C

electronic software delivery (ESD)  step d

¢ Addin the MR OM Collector package from the CD-ROM by
typing
> pkgadd -d
/cdrom/cdrom0/<NTmg9k_MR OM_collector_packag
e_name>.pkg

The following packages are available:
1 NTomclt08 Succession Operational
Measurement Collector
(sparc) NTOMCLTR_08_42_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,gl:1

Go to step e.

('SN08 Standard 07.02 June 2005
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14

15

16

d Addin the MR OM Collector package from ESD by typing

> pkgadd -4
/data/loads/<MG9K_MR_OM_ Collector package na
me> .pkg

The following packages are available:
1 NTomclt08 Succession Operational
Measurement Collector
(sparc) NTOMCLTR_08_42_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,g]l:1

e Start the MR OM collector by typing
> servstart <omcollector>

Install the new MR release GUI client. Refer to procedure
Installing the MG 9000 Sun client software on page 9 for a Sun
workstation, or to procedure Installing the MG 9000 Manager
Windows PC client software on page 7 for a Windows PC.

Reconnect any SNO8 third party application that retrieves
alarms for delivery to Operations Support System (OSS) fault
management systems.

This procedure is complete.

Upgrading the MG 9000
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Upgrading MG 9000 Manager software to a maintenance release in
an HA-Cluster setup

At the MG 9000 Manager

1 Upgrade the hardware, if necessary. Ensure the connection from
the MG 9000 Manager to the MG 9000 is up.

2 To stop the GUI clients, click on File->Exit from the GUI to exit.

3 Telnet into the active server through the cluster IP address and
log in as root.

All MR upgrades are performed on the standby node while the
active node is providing service. After the standby node of the
cluster is upgraded and configured, perform a failover so the
standby node becomes active. After determining that both nodes
are functional, the newly active node with the MR update can be
cloned to the standby node. This will ensure both nodes or units
of the cluster have the same data image.

4 Determine which of the cluster nodes is in standby so it can be
upgraded with the MR.

5 Telnet to the cluster IP address, log in as root and type:
# bash

The cluster prompt changes showing the unit and the status of
the unit.

mgem_ha_srv-unitO (active) :/>

6 Remove the old MG 9000 Manager server application on
standby unit by typing

> pkgrm NTmg9ks08

The following package is currently installed:

NTmg9ks08 Succession MG 9000 Manager Server
(sparc) NTMGO9KS_8_44_0

Do you want to remove this package? Y

7 Install the MR release on the standby unit for the MG 9000
Manager server application by performing the following steps:

a Use the following table to determine the next step.

If installing the master Do
server software from

CD-ROM step b

electronic software delivery (ESD)  step C
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b Addinthe MG 9000 Manager server package from CD-ROM

by typing

> pkgadd -4
/cdrom/cdrom0/<MG9K_MR server_ package_name>.
pkg

The following packages are available:

1 NTmg9ks08 Succession MG 9000 Manager Server
(sparc) NTMGO9KS_8_441_0

Select package(s) you wish to process (or

‘all’ to process all packages).

(default: all) [?,??,g]l:1

Go to step d.

Add in the MG 9000 Manager MR server package from ESD
by typing

> pkgadd -4
/data/loads/<MG9K MR midtier package_ name>.p
kg

The following packages are available:
1 NTmg9km08 Succession MG 9000 Manager
Midtier Server
(sparc) NTMGO9KM_8_44_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,g]:1
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d Configure the MG 9000 Manager server application by typing

> /opt/nortel/mg9ksrv_08/bin/mg9kconfig.sh
The system responds with the following message:

R R IR I i b b S b b b S b b S b b b i b b b b e b b S b S R R I b S b b b S

Setup Server As : MASTER

Master Server IP Address : 47 . xxx.xx.207
SESM IP Address : 47 .xxx.x%x.220
Security Authentication Host: 47.xxx.xx.220
Oracle IP Address : 47 .xxXx.xX.8
Image Server : 47 .xxx.xx.207
Image Server User ID : maint

SuperCore Gige Image Dlrectory /swd/mg9k
SuperCore IMA Image Directory: /swd/mg9k
SuperCore OC3 Image Dlrectory /swd/mg9k

ITP Image Directory : /swd/mg9k
ITX Image Directory : /swd/mg9k
ABI Image Directory : /swd/mg9k
DS1 Image Directory : /swd/mg9k

ER IR R R I S I b S b b S b S S b S A b b S b b S b R S S b R S S b S

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n]=>y

Install the MR release MG 9000 Manager mid-tier server
application on the standby unit by performing the following steps:

a Remove the old mid-tier package by typing

> pkgrm NTmg9kmO08

The following packages are available:
1 NTmg9km08 Succession MG 9000 Manager
Midtier Server
(sparc) NTMGOKM_8_44_0
Do you want to remove this package? y

b Use the following table to determine the next step.

If installing the mid-tier Do
server software from

CD-ROM step C

electronic software delivery (ESD)  step d
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¢ Add in the MR mid-tier package from CD-ROM by typing

> pkgadd -4
/cdrom/cdrom0/<MG9K_MR midtier package_ name>
-Pkg

The following packages are available:
1 NTmg9km08 Succession MG 9000 Manager
Midtier Server
(sparc) NTMGOKM_ 8_441_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,g]l:1

Gotostepe
Add in the MR mid-tier package from ESD by typing

> pkgadd -4
/data/loads/<MGY9K_MR midtier package name>.p
kg

The following packages are available:
1 NTmg9km08 Succession MG 9000 Manager
Midtier Server
(sparc) NTMGO9KM_8_44_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,g]l:1

Configure the mid-tier by typing
> /opt/nortel/mg9ksrv_08/bin/mg9kconfig.sh

Setup has detected configuration settings
from a previous installation.

AR IR IR b b b b I b b S i i b S I i i i i i I i i i i O O i i b i i I S O i b b i
Master Server IP Address i 47 . xxx.xx.209

Security Authentication Host : 47 .xxx.xx.208
PR I b b b b b I b I I b b b b b b b b b b b b b b b I b b b b b b b b b b b I b b 4

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] => vy
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9 Install and start the SNO8 MR OM collection application on the
standby unit by performing the following:

a Remove the old SNO8 OM collector package by typing
> pkgrm NTomclt08

The following packages are available:
1 NTomcltmO8 Succession Operational
Measurement Collector

(sparc) NTOMCLTR_8_44_0
Do you want to remove this package? y

b Use the following table to determine the next step.

If installing the OM Collec- Do
tor software from

CD-ROM step C

electronic software delivery (ESD)  step

¢ Add in the MR OM collector package from the CD-ROM by
typing
> pkgadd -d
/cdrom/cdrom0/<NTmg9k MR OM collector_ packag
e_name>.pkg

The following packages are available:
1 NTomclt08 Succession Operational
Measurement Collector
(sparc) NTOMCLTR_8_441_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,gl:1

Make the standby unit to be active now by
causing the old active unit to failover and
switch states with the standby unit that has
currently been upgraded.

To create a failover, telnet to the cluster IP address, login into
active unit and type:

> swact
Note: The failover can take around 5 minutes or more
Go to step 10.
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10

11

12
13

14

15

d Addin the MR OM Collector package from ESD by typing

> pkgadd -4
/data/loads/<MG9K_MR_OM_ Collector package na
me> .pkg

The following packages are available:
1 NTomclt08 Succession Operational
Measurement Collector
(sparc) NTOMCLTR_08_42_0
Select package(s) you wish to process (or
‘all’ to process all packages).
(default: all) [?,??,g]l:1

Make the standby unit to be active now by
causing the old active unit to failover and
switch states with the standby unit that has
currently been upgraded.

To create a failover, telnet to the cluster IP address, login into
active unit and type:

> swact
Note: The failover can take around 5 minutes or more

Install the new MR release GUI client. Refer to procedure
Installing the MG 9000 Sun client software on page 9 for a Sun
workstation, or to procedure Installing the MG 9000 Manager
Windows PC client software on page 7 for a Windows PC.
Connect the client by pointing to the virtual IP address of the
cluster.

Verify the newly active unit recovers by typing the following
command while logged into the cluster IP address

> servquery -status all
Launch the MG 9000 Manager client.

Reconnect any SNO8 third party application that retrieves
alarms for delivery to Operations Support System (OSS) fault
management systems.

Once it is determined that the newly active node with the MR
update is fully functional, mirror the newly active node to the
standby node so both nodes have the same image. Perform
procedure “Cloning the image of one node in a cluster to the
other node” in Upgrading a Carrier Voice over IP Network,
NN10440-450.

This procedure is complete.
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Downgrading the MG 9000 and MG 9000 Manager from SNO8 to
SNO06.2 or SNO7

When to use this procedure

When it is necessary to downgrade the MG 9000 and MG 9000
Manager from SN08 to SN06.2 or SNO7, perform this downgrade
procedure.

Before continuing, consider the following service impacts:

* Earlier releases of the MG 9000 Manager cannot run in tandem with
the SNO8 MG 9000 Manager.

e |f the customer wants to run an SN06.2 MG 9000 Manager (and
thus not an SN08 MG 9000 Manager), both the SSPFS and
MG 9000 Manager must be at SN06.2. Different platform version of
MG 9000 Manager and SSPFS cannot be mixed.

* During a downgrade, the GWC cannot be downgraded until all
MG 9000 network elements that subtend it are downgraded.

* When collection interval is set to 5/30 minutes, if an MG 9000
network element is downgraded to an older release, then OM
collection is disabled for the downgraded NE. The downgraded NE
cannot collect performance data.

e |f an MG 9000 has been placed within a Community of Interest
(CQI) to support Internodal ESA, and it is downgraded, an error
message appears notifying the user that the downgrade cannot
continue until the network element is removed from the COI.

* |f NTNY53AB Global Line cards (GLC) have been installed in an
SN08 MG 9000, any attempt to downgrade to SN06.2 or SNO7 will
render the NTNY53AB non-functional. The NTNY53AB GLC cards
must be deprovisioned and removed before attempting the
downgrade.

SNO06.2 MG 9000 loads do not support P-phone and
postGroundStart line service for GLC cards. When downgrading to
an SN06.2 MG 9000 load, P-phone and postGroundStart lines
provisioned on the GLC cards must be provisioned prior to
attempting the downgrade.

Prerequisites
There are no prerequisites.
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Action

Downgrading the MG 9000 and the t1400 or N240 simplex
configuration MG 9000 Manager from SN08 to SN06.2

At the MG 9000 Manager server

1

If the cards are currently on version SN0O8, perform a downgrade
on all the cards on the NE to go back to their SN06.2 version
using the procedure “Upgrading the MG 9000 to SNO8 using the
CLI mg9kuptool” in Upgrading a Carrier Voice over IP Network,
NN10440-450. When using the mg9kuptool, select the SN06.2
loads appropriate for each card when configuring the
downgrade. Wait for the entire downgrade to complete before
proceeding.

Stop the MG 9000 Manager server application. To stop the
server, type

> servstop MGY9KSERVER 08

Stop the MG 9000 Manager mid-tier application. To stop the
application, type

> servstop MG9KMIDTIER_ 08
Drop the SNO8 tablespace by typing

>
/opt/nortel/mg9ksrv_08/bin/mgems_ora_ts_drop.s
h

To verify the MG 9000 mid-tier and server applications are
stopped, type

> servquery -status all

To remove the master server SN0O8 software, type
> pkgrm NTmg9ks08

To continue, respond to the prompt with Y.

To remove the mid-tier server SNO8 software, type
> pkgrm NTmg9kmO8

To continue, respond to the prompt with .

Downgrade both the mid-tier server and the master server to the
SNO06.2 SSPFS platform.

Details about downgrading the SSPFS platform are provided in
procedures “Performing a full system restore on an
SSPFS-based server” in ATM/IP Fault Management,
NN10408-900.

Upgrading the MG 9000



Copyright © 2005, Nortel Networks 34 Nortel Networks Confidential

NN10048-461

9 At the workstation dedicated as the MG 9000 Manager master
server, install the master server software using the following
steps:

a Login as root (superuser) and insert the Succession MG
9000 Manager software CD into the CD-ROM drive. This
server is also running the OpenOrb NamingService.

b At the prompt (#), use pkgadd to install the server portion
(NTmg9ks062.pkg) of the software. To directly install the
software from the CD-ROM use the following commands to
read the CD-ROM and list the contents to read the release
number:

# cd /cdrom/cdromO/
# 1s

# pkgadd -4
/cdrom/cdrom0/NTmg9ks 6 2 xx 0.pkg

The system responds with the following:

The following packages are available:

1 NTmg9ks62 Succession MG 9000 Manager
Server (sparc) 6_2.44

Select package (s) you wish to process (or
‘all’ to process all packages). (default:
all) [?,??,g9]:

¢ Enter “1” and press return to begin the server installation
process.

Note: The following message may appear requiring a Y
in response to the prompt:

The following files are already installed on
the system and are being used by another
package: /opt/Nortel<attribute change only>
Do you want to install these conflicting
files [v,n,?,q]

After the installation is compete, a message appears
reporting that the installation was successful.

d The package is processed and the following information is
displayed.

Processing package instance <NTmg9ks62> from
</NTmg9ks62 .pkg>

Succession MG 9000 Manager Server (sparc)
6_2.44
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Copyright (c) 1998-2003 Nortel Networks All
Rights Reserved

Note: Verify that the “Installation of <NTmg9ks62> was
successful” If there are any errors please contact your next
level of support.

Eject the CD-ROM.
To configure the master server, type
> /opt/nortel/mg9ksrv_06_2/bin/mg9kconfig.sh

Setup has detected configuration settings

from a previous installation.
AR IR I b b b I I R b S i i i S I i i i i i b i i i S I S S i i b i i i I S S i i i

* %

Setup Server As : MASTER

Master Server IP Address : 47 .xxx.xx.215
SESM IP Address 47 .xxx.xx.220
Security Authentication Host : 47.xxx.xx.215

Oracle IP Address : 47 .xxx.xx.220
Initialize Database : YES

Maintenance Release Upgrade : NO
R b b b b b b b b b S I b b S I I I I b I b b I I I I I I I I I b b I b I I I b i b

* %

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Note: The database is not initialized until the server is
restarted.

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.

To start the master server, enter the following command:

# /opt/nortel/mg9ksrv 06_2/bin/mg9kserver
start

Note: Messages may appear indicating that a “patch
failed to stay up.” These messages can be ignored.

At the workstation dedicated as the MG 9000 Manager mid-tier
server, install the mid-tier server software by performing the
following steps:

a Login as root (superuser) and insert the CD containing the

Succession MG 9000 Manager software into the CD-ROM
drive.
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b Collect the current configuration by typing

# /opt/nortel/mg9kmtr 06/bin/mg9kmidtier
config

Enter 4 and press Return from the list to display the current
settings.

Enter 5 and press Return to exit the Configuration menu.

At the prompt (#) use pkgadd to install the mid-tier portion
(NTmg9km62.pkg) of the software. If you are directly
installing from the CD-ROM use the following command to
read the CD-ROM, and list the contents to read the release
number:

# cd /cdrom/cdromO/
# 1s

# pkgadd -4
/cdrom/cdrom0/NTmg9km_6_2 xx 0.pkg

where xx is the release number.
The system responds with the following information.

The following packages are available:
1 NTmg9kmé62 Succession MG 9000 Manager
Midtier Server (sparc) 6_2.44

Select package(s) you wish to process (or
'all' to process all packages). (default:
all) [?,??2,g]: all

Enter 1 and press Return to begin the server installation
process.

The system responds as follows:

Executing checkinstall script.Using </opt> as
the package base directory.Processing package
information.Processing system information.l1l
package pathname is already properly
installed.

Note: If a message appears with a confirmation prompt to
overwriting conflicting files, respond Y. If existing files are
not overwritten, the MG 9000 Manager mid-tier server
upgrade cannot continue.

Verifying disk space requirements.Checking
for conflicts with packages already
installed.Checking for setuid/setgid
programs.
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This package contains scripts which will be
executed with super-user permission during
the process of installing this package.

Do you want to continue with the installation
of <NTmg9kmé62> [y, n, ?]

# Y

Note: Verify that “Installation of <NTmg9km_6_2_xx_0>
was successful.” If there are any errors please contact your
next level of support.

The installation continues automatically and installs all the
mid-tier server files in /opt/nortel/mg9kmtr_06_2
subdirectory as noted in the system response.

Installing Succession MG 9000 Manager Midtier
Server as <NTmg9kmé62>

## Installing part 1 of 1.

Configuring system, please wait

Installation of <NTmg9kmé62> was successful.
The Installation is complete.

After the installation is compete, a message appears
reporting that the installation was successful.

Eject the CD from the CD-ROM drive.
To configure the mid-tier server, type
# /opt/nortel/mg9kmtr 06 2/bin/mg9kconfig.sh

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.

The system responds as follows.

Setup has detected configuration settings
from a previous installation. If you choose
to continue, your username and password from
the previous installation will be used.

R R IR R S b b S b I b i b b S b S b b i b b b b e b b S b S R R I R S b b e b i b S

IP Address : 47 . xxx . xxx.215
SSL enabled : true
Security Authentication Host : 47.xxx.xx.235

ERE I R R S S I b b b b S b b S b b S A b b S b S A b R S S b R S S b S
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Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Enter Y to accept the default values.
>Y
j Enter the following command to start the mid-tier server.

# /opt/nortel/mg9kmtr 06 _2/bin/mg9kmidtier
start

Press the Enter key again for the login prompt to appear.
11 This procedure is complete.
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Downgrading the N240 HA cluster configuration MG 9000 Manager
from SNO8 to SN06.2

At the MG 9000 Manager server

1

If the cards are currently on version SN0O8, perform a downgrade
on all the cards on the NE to go back to their SN06.2 version
using the procedure “Upgrading the MG 9000 to SN08 using the
CLI mg9kuptool” in Upgrading a Carrier Voice over IP Network,
NN10440-450. When using the mg9kuptool, select the SN06.2
loads appropriate for each card when configuring the
downgrade. Wait for the entire downgrade to complete before
proceeding.

Use the information in the following table to determine the next
step.

If the inactive side is cur- Do
rently running

SN06.2 step 8
SN08 step 3

On the inactive side, remove the master server SN08 software
by typing

> pkgrm NTmg9ks08

To continue, respond to the two prompts with Y.

On the inactive side, remove the mid-tier server SN0O8 software
by typing

> pkgrm NTmg9kmO08

To continue, respond to the two prompts with Y.

On the inactive side, downgrade both the mid-tier server and the
master server to the SN06.2 SSPFS platform.

Note 1: Ensure the master server is restarted before mid-tier
server.

Note 2: If the mid-tier server comes up before the master
server, it will go through a restart loop until the master server
comes up.

Details about downgrading the SSPFS platform are provided in
procedures “Performing a full system restore on an
SSPFS-based server” in ATM/IP Fault Management,
NN10408-900.

On the inactive side, install the master server software using the
following steps:
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a Login as root (superuser) and insert the Succession MG

9000 Manager software CD into the CD-ROM drive. This
server is also running the OpenOrb NamingService.

At the prompt (#), use pkgadd to install the server portion
(NTmg9ks062.pkg) of the software. To directly install the
software from the CD-ROM use the following commands to
read the CD-ROM and list the contents to read the release
number:

# cd /cdrom/cdromO0/
# 1ls

# pkgadd -4
/cdrom/cdrom0/NTmg9ks_6_2 xx 0.pkg

The system responds with the following:

The following packages are available:

1 NTmg9ks62 Succession MG 9000 Manager
Server (sparc) 6_2.44

Select package (s) you wish to process (or
‘all’ to process all packages). (default:
all) [?,??,g]:

Enter “1” and press return to begin the server installation
process.

Note: The following message may appear requiring a Y
in response to the prompt:

The following files are already installed on
the system and are being used by another
package: /opt/Nortel<attribute change only>
Do you want to install these conflicting
files [vy,n,?,ql

After the installation is compete, a message appears
reporting that the installation was successful.

The package is processed and the following information is
displayed.

Processing package instance <NTmg9ks62> from
</NTmg9ks62 .pkg>

Succession MG 9000 Manager Server (sparc)
6_2.44

Copyright (c) 1998-2003 Nortel Networks All
Rights Reserved
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Note: Verify that the “Installation of <NTmg9ks62> was
successful” If there are any errors please contact your next
level of support.

Eject the CD-ROM.
To configure the master server, type
> /opt/nortel/mg9ksrv _06_2/bin/mg9kconfig.sh

Setup has detected configuration settings

from a previous installation.
R b b b b b b b b b S I b b S I I I I I b b b b I I I I I I b b b b b b I I I b b b

* %

Setup Server As : MASTER

Master Server IP Address : 47 .xxxX.xxX.215
SESM IP Address 47 .xxx.xx.220
Security Authentication Host : 47.xxx.xx.215

Oracle IP Address : 47 .xxx.xx.220
Initialize Database : YES

Maintenance Release Upgrade : NO
R I I b b S b I b b b b b b b I b b b I b b b b I b b b b b b b b b b b b b b b b

* %

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Note: The database is not initialized until the server is
restarted.

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.

On the inactive side, install the mid-tier server software by
performing the following steps:

a Login as root (superuser) and insert the CD containing the

Succession MG 9000 Manager software into the CD-ROM
drive.

b At the prompt (#) use pkgadd to install the mid-tier portion

(NTmg9km62.pkg) of the software. If you are directly
installing from the CD-ROM use the following command to
read the CD-ROM, and list the contents to read the release
number:

# cd /cdrom/cdrom0/
# 1s

# pkgadd -4
/cdrom/cdrom0/NTmg9km 6 2 xx 0.pkg
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d

where xx is the release number.
The system responds with the following information.

The following packages are available:
1 NTmg9km62 Succession MG 9000 Manager
Midtier Server (sparc) 6_2.44

Select package(s) you wish to process (or
'all' to process all packages). (default:
all) [?,??,gq]: all

Enter 1 and press Return to begin the server installation
process.

The system responds as follows:

Executing checkinstall script.Using </opt> as
the package base directory.Processing package
information.Processing system information. 1
package pathname is already properly
installed.

Note: If amessage appears with a confirmation prompt to
overwriting conflicting files, respond Y. If existing files are
not overwritten, the MG 9000 Manager mid-tier server
upgrade cannot continue.

Verifying disk space requirements.Checking
for conflicts with packages already
installed.Checking for setuid/setgid
programs.

This package contains scripts which will be
executed with super-user permission during
the process of installing this package.

Do you want to continue with the installation
of <NTmg9kmé62> [y,n, ?]

# Y

Note: Verify that “Installation of <NTmg9km_6_2_xx_0>
was successful.” If there are any errors please contact your
next level of support.

The installation continues automatically and installs all the
mid-tier server files in /opt/nortel/mg9kmtr_06_2
subdirectory as noted in the system response.

Installing Succession MG 9000 Manager Midtier
Server as <NTmg9kmé62>
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## Installing part 1 of 1.

Configuring system, please wait

Installation of <NTmg9kmé62> was successful.
The Installation is complete.

After the installation is compete, a message appears
reporting that the installation was successful.

e To configure the mid-tier server, type
# /opt/nortel/mg9kmtr_ 06_2/bin/mg9kconfig.sh

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.

f The system responds as follows.

Setup has detected configuration settings
from a previous installation. If you choose
to continue, your username and password from
the previous installation will be used.

ERE I R R S b b S b b b b S b b S S b b S S b S A b R S S b R S S b S

IP Address : 47 .xxXx.xxxX.215
SSL enabled : true
Security Authentication Host : 47.xxx.xx.235

R R IR b S b b S b I b i b b I b b b i b b b b e b b S b S R R I b S b b b S b S

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Enter Y to accept the default values.
>Y

g Install and configure the SN06.2 OM Collector software by
performing procedure “Installing OM Collector software” in
the SN06.2 version of MG 9000 Performance Management,
NN10140-711.

h Eject the CD from the CD-ROM drive.

On the active side, stop the MG 9000 Manager server
application. To stop the server, type

> servstop MGY9KSERVER 08
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9 On the active side, stop the MG 9000 Manager mid-tier
application. To stop the application, type

> servstop MG9KMIDTIER_ 08
10 Drop the SNO8 tablespace by typing

>
/opt/nortel/mg9ksrv_08/bin/mgems_ora_ts_drop.s
h

11 Telnet to the cluster IP address, login to the active unit and
perform a failover of the system by typing

> init 6

12 This procedure is complete.
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Downgrading the 11400 or N240 simplex configuration MG 9000
Manager from SNO8 to SNO7

At the MG 9000 Manager server

1

If the cards are currently on version SN0O8, perform a downgrade
on all the cards on the NE to go back to their SNO7 version using
the procedure “Upgrading the MG 9000 to SNO8 using the CLI
mg9kuptool” in Upgrading a Carrier Voice over IP Network,
NN10440-450. When using the mg9kuptool, select the SNO7
loads appropriate for each card when configuring the
downgrade. Wait for the entire downgrade to complete before
proceeding.

Stop the MG 9000 Manager server application. To stop the
server, type

> servstop MGI9KSERVER 08

Stop the MG 9000 Manager mid-tier application. To stop the
application, type

> servstop MG9KMIDTIER_ 08
Drop the SNO8 tablespace by typing

>
/opt/nortel/mg9ksrv_08/bin/mgems_ora_ts_drop.s
h

To verify the MG 9000 mid-tier and server applications are
stopped, type

> servquery -status all

Restore the SNO7 tablespace data from the file that was saved
during the SNO8 upgrade process by typing

>
/opt/nortel/mg9ksrv_08/bin/mgems_ora_ts_restor
e.sh <name of the file where the SN07 data was
backed up>

Refer to procedure “Upgrading MG 9000 Manager software from
SNO06.2 or SNO7 to SNO08” step 1e, in Upgrading a Carrier Voice
over IP Network, NN10440-450.

To remove the master server SNO8 software, type
> pkgrm NTmg9ks08
To continue, respond to the prompt with Y.
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8

10

To remove the mid-tier server SNO8 software, type
> pkgrm NTmg9kmO8
To continue, respond to the prompt with .

Downgrade both the mid-tier server and the master server to the
SNO7 SSPFS platform.

Details about downgrading the SSPFS platform are provided in
procedures “Performing a full system restore on an
SSPFS-based server” in ATM/IP Fault Management,
NN10408-900.

At the workstation dedicated as the MG 9000 Manager master
server, install the master server software using the following
steps:

a Login as root (superuser) and insert the Succession MG
9000 Manager software CD into the CD-ROM drive. This
server is also running the OpenOrb NamingService.

b At the prompt (#), use pkgadd to install the server portion
(NTmg9ks07.pkg) of the software. To directly install the
software from the CD-ROM use the following commands to
read the CD-ROM and list the contents to read the release
number:

# cd /cdrom/cdrom0/
# 1ls

# pkgadd -4
/cdrom/cdrom0/NTmg9ks_07_xx 0.pkg

The system responds with the following:

The following packages are available:

1 NTmg9ks07 Succession MG 9000 Manager
Server (sparc) 07.44

Select package (s) you wish to process (or
‘all’ to process all packages). (default:
all) [?,??,g9]:

¢ Enter “1” and press return to begin the server installation
process.

Note: The following message may appear requiring a Y
in response to the prompt:
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The following files are already installed on
the system and are being used by another
package: /opt/Nortel<attribute change only>
Do you want to install these conflicting
files [vy,n,?,ql

After the installation is compete, a message appears
reporting that the installation was successful.

The package is processed and the following information is
displayed.

Processing package instance <NTmg9ks07> from
</NTmg9ks07 .pkg>

Succession MG 9000 Manager Server (sparc)
07.44

Copyright (c) 1998-2003 Nortel Networks All
Rights Reserved

Note: Verify that the “Installation of <NTmg9ks62> was
successful” If there are any errors please contact your next
level of support.

Eject the CD-ROM.
To configure the master server, type
> /opt/nortel/mg9ksrv_07/bin/mg9kconfig.sh

Setup has detected configuration settings

from a previous installation.
AR A b b b b I R b S i i b b I I i i b i i I i i b O O i i b i S I S i i b b i

* %

Setup Server As : MASTER

Master Server IP Address : 47 .xxx.xx.215
SESM IP Address 47 .xxx.xx.220
Security Authentication Host : 47.xxx.xx.215

Oracle IP Address : 47 .xxx.xx.220
Initialize Database : YES

Maintenance Release Upgrade : NO
R b b b b b b b b b S I b b I I I I I b b b b b I I I I I I I b b b I b I I i b b b ]

* %

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Note: The database is not initialized until the server is
restarted.

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.
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f To start the master server, enter the following command:
# servstart MGO9KSERVER_ 07

Note: Messages may appear indicating that a “patch
failed to stay up.” These messages can be ignored.

11 At the workstation dedicated as the MG 9000 Manager mid-tier
server, install the mid-tier server software by performing the
following steps:

a Login as root (superuser) and insert the CD containing the
Succession MG 9000 Manager software into the CD-ROM
drive.

b At the prompt (#) use pkgadd to install the mid-tier portion
(NTmg9kmO07.pkg) of the software. If you are directly
installing from the CD-ROM use the following command to
read the CD-ROM, and list the contents to read the release
number:

# cd /cdrom/cdromO/
# 1ls

# pkgadd -4
/cdrom/cdrom0/NTmg9km 07_xx 0.pkg

where xx is the release number.
The system responds with the following information.

The following packages are available:
1 NTmg9km07 Succession MG 9000 Manager
Midtier Server (sparc) 6_2.44

Select package(s) you wish to process (or
'all' to process all packages). (default:
all) [?,??,gq]: all

¢ Enter 1 and press Return to begin the server installation
process.

The system responds as follows:

Executing checkinstall script.Using </opt> as
the package base directory.Processing package
information.Processing system information.1l
package pathname is already properly
installed.

Note: If amessage appears with a confirmation prompt to
overwriting conflicting files, respond Y. If existing files are
not overwritten, the MG 9000 Manager mid-tier server
upgrade cannot continue.
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Verifying disk space requirements.Checking
for conflicts with packages already
installed.Checking for setuid/setgid
programs.

This package contains scripts which will be
executed with super-user permission during
the process of installing this package.

Do you want to continue with the installation
of <NTmg9km07> [v,n, ?]

# Y

Note: Verify that “Installation of <NTmg9km_07_xx_0>
was successful.” If there are any errors please contact your
next level of support.

The installation continues automatically and installs all the
mid-tier server files in /opt/nortel/mg9kmtr_07 subdirectory
as noted in the system response.

Installing Succession MG 9000 Manager Midtier
Server as <NTmg9kmQ07>

## Installing part 1 of 1.

Configuring system, please wait

Installation of <NTmg9kmO07> was successful.
The Installation is complete.

After the installation is compete, a message appears
reporting that the installation was successful.

e Eject the CD from the CD-ROM drive.
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12

f To configure the mid-tier server, type

# /opt/nortel/mg9kmtr 07/bin/mg9kconfig.sh

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.

The system responds as follows.

Setup has detected configuration settings
from a previous installation. If you choose
to continue, your username and password from
the previous installation will be used.

R R IR b i b S b I b S b b S b b b i b i b b e b S b S R R b S b b b S

IP Address 1 47 . xxx.xxx.215
SSL enabled : true
Security Authentication Host : 47.xxx.xx.235

ERIE I R R S S I b S b b b b S b b S b b S b b S A b R S S b R S S b S

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Enter Y to accept the default values.

>Y

Enter the following command to start the mid-tier server.
# servstart MGOKMIDTIER_ 07

Press the Enter key again for the login prompt to appear.

Install and configure the SNO7 OM Collector software by
performing procedure “Installing OM Collector software” in
the SNO7 version of MG 9000 Performance Management,
NN10140-711.

This procedure is complete.
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Downgrading the N240 HA cluster configuration MG 9000 Manager
from SNO8 to SNO7

At the MG 9000 Manager server

1

If the cards are currently on version SN0O8, perform a downgrade
on all the cards on the NE to go back to their SNO7 version using
the procedure “Upgrading the MG 9000 to SNO8 using the CLI
mg9kuptool” in Upgrading a Carrier Voice over IP Network,
NN10440-450. When using the mg9kuptool, select the SN06.2
loads appropriate for each card when configuring the
downgrade. Wait for the entire downgrade to complete before
proceeding.

Use the information in the following table to determine the next
step.

If the inactive side is cur- Do
rently running

SNO7 step 8
SN08 step 3

On the inactive side, remove the master server SN08 software
by typing

> pkgrm NTmg9ks08

To continue, respond to the two prompts with Y.

On the inactive side, remove the mid-tier server SN0O8 software
by typing

> pkgrm NTmg9kmO08

To continue, respond to the two prompts with Y.

On the inactive side, downgrade both the mid-tier server and the
master server to the SNO7 SSPFS platform.

Details about downgrading the SSPFS platform are provided in
procedures “Performing a full system restore on an
SSPFS-based server” in ATM/IP Fault Management,
NN10408-900.

On the inactive side, install the master server software using the
following steps:

a Login as root (superuser) and insert the Succession MG
9000 Manager software CD into the CD-ROM drive. This
server is also running the OpenOrb NamingService.
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b At the prompt (#), use pkgadd to install the server portion

(NTmg9ks07.pkg) of the software. To directly install the
software from the CD-ROM use the following commands to
read the CD-ROM and list the contents to read the release
number:

# cd /cdrom/cdromO/
# 1s

# pkgadd -4
/cdrom/cdrom0/NTmg9ks 07_xx 0.pkg

The system responds with the following:

The following packages are available:

1 NTmg9ks07 Succession MG 9000 Manager
Server (sparc) 07.44

Select package (s) you wish to process (or
‘all’ to process all packages). (default:
all) [?,??,g9]:

Enter “1” and press return to begin the server installation
process.

Note: The following message may appear requiring a Y
in response to the prompt:

The following files are already installed on
the system and are being used by another
package: /opt/Nortel<attribute change only>
Do you want to install these conflicting
files [v,n,?,q]

After the installation is compete, a message appears
reporting that the installation was successful.
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d The package is processed and the following information is
displayed.
Processing package instance <NTmg9ks07> from
</NTmg9ks07.pkg>

Succession MG 9000 Manager Server (sparc)
07.44

Copyright (c) 1998-2003 Nortel Networks All
Rights Reserved

Note: Verify that the “Installation of <NTmg9ks07> was
successful” If there are any errors please contact your next
level of support.

Eject the CD-ROM.
e To configure the master server, type
> /opt/nortel/mg9ksrv_06_2/bin/mg9kconfig.sh

Setup has detected configuration settings

from a previous installation.
AR IR b b b b b R b S i i b S S I i i i b i I i i b i I S S i i i i i i i S S i i i

* %

Setup Server As : MASTER

Master Server IP Address : 47 .xxx.xx.215
SESM IP Address 47 .xxx.xx.220
Security Authentication Host : 47.xxx.xx.215

Oracle IP Address : 47 .xxx.xx.220
Initialize Database : YES

Maintenance Release Upgrade : NO
R b b b b b b b b b S I b b b I I I I b b b b b I I I I I I I b b b I I I I i b b b ]

* %

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Note: The database is not initialized until the server is
restarted.

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.

7 On the inactive side, install the mid-tier server software by
performing the following steps:

a Login as root (superuser) and insert the CD containing the
Succession MG 9000 Manager software into the CD-ROM
drive.
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b At the prompt (#) use pkgadd to install the mid-tier portion

(NTmg9kmO07.pkg) of the software. If you are directly
installing from the CD-ROM use the following command to
read the CD-ROM, and list the contents to read the release
number:

# cd /cdrom/cdromO/
# 1s

# pkgadd -4
/cdrom/cdrom0/NTmg9km 07_xx 0.pkg

where xx is the release number.
The system responds with the following information.

The following packages are available:
1 NTmg9km07 Succession MG 9000 Manager
Midtier Server (sparc) 07.44

Select package(s) you wish to process (or
'all' to process all packages). (default:
all) [?,??,gq]l: all

Enter 1 and press Return to begin the server installation
process.

The system responds as follows:

Executing checkinstall script.Using </opt> as
the package base directory.Processing package
information.Processing system information.l1l
package pathname is already properly
installed.

Note: If a message appears with a confirmation prompt to
overwriting conflicting files, respond Y. If existing files are
not overwritten, the MG 9000 Manager mid-tier server
upgrade cannot continue.

Verifying disk space requirements.Checking
for conflicts with packages already
installed.Checking for setuid/setgid
programs.

This package contains scripts which will be
executed with super-user permission during
the process of installing this package.

Do you want to continue with the installation
of <NTmg9km07> [v,n, ?]

# Y
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Note: Verify that “Installation of <NTmg9km_07_xx_0>
was successful.” If there are any errors please contact your
next level of support.

d The installation continues automatically and installs all the

mid-tier server files in /opt/nortel/mg9kmtr_07 subdirectory
as noted in the system response.

Installing Succession MG 9000 Manager Midtier
Server as <NTmg9km07>

## Installing part 1 of 1.

Configuring system, please wait

Installation of <NTmg9kmO07> was successful.
The Installation is complete.

After the installation is compete, a message appears
reporting that the installation was successful.

Eject the CD from the CD-ROM drive.
To configure the mid-tier server, type
# /opt/nortel/mg9kmtr 07/bin/mg9kconfig.sh

If previous installation settings are detected, the installation
will ask if the previous settings should be accepted.

The system responds as follows.

Setup has detected configuration settings
from a previous installation. If you choose
to continue, your username and password from
the previous installation will be used.

R R IR I b i b b S b I b i b b S b S b b I b b b b e b b S b S R R I R S b b e b b b b

IP Address 1 47 . xxx.xxx.215
SSL enabled : true
Security Authentication Host : 47.xxx.xx.235

ERIE I R R S I b S b b b b S b b S b b S I b R S A b R S S b R S S b S S

Is the above information correct?

Press the enter key to accept the default
(y/n)?

Default: [n] =>

Enter Y to accept the default values.
> Y
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10

11

12

13

h On the inactive side, install and configure the SNO7 OM
Collector software by performing procedure “Installing OM
Collector software” in the SNO7 version of MG 9000
Performance Management, NN10140-711.

On the active side, stop the MG 9000 Manager server
application. To stop the server, type

> servstop MGY9KSERVER 08

On the active side, stop the MG 9000 Manager mid-tier
application. To stop the application, type

> servstop MG9KMIDTIER_ 08
On the active side, drop the SNO8 tablespace by typing

>
/opt/nortel/mg9ksrv_08/bin/mgems_ora_ts_drop.s
h

On the active side, restore the SNO7 tablespace data from the
file that was saved during the SNO8 upgrade process by typing

>

/opt/nortel/mg9ksrv _08/bin/mgems_ora_ts_restor
e.sh <name of the file where the SN07 data was
backed up>

Refer to procedure “Upgrading MG 9000 Manager software from
SNO06.2 or SNO7 to SNO8” step 1e, in Upgrading a Carrier Voice
over IP Network, NN10440-450.

Telnet to the cluster IP address, login to the active unit and
perform a failover of the system by typing

> init 6

This procedure is complete.

('SN08 Standard 07.02 June 2005



Copyright © 2005, Nortel Networks 57 Nortel Networks Confidential

Patching MG 9000 Manager software

The MG 9000 Manager server, mid-tier, and OM Collector are patched
using the Network Patching Manager (NPM) patching system. The user
must restart the server, mid-tier, and OM Collector applications through
the NPM following application or removal of patches.

For information and procedures for patching the MG 9000 Manager
software using the NPM, refer to the Succession Patching chapter in
Upgrading a Carrier Voice over IP Network, NN10440-450.

The following logs are generated when the MG 9000 Manager server
shuts down or starts:

* MGEM700 - The element manger server is starting.

* MGEM702 - The mid-tier server is now starting.

e MGEM703 - The mid-tier server is shutting down.

e OMC700 - The OM Collector process was started.

e OMC701 - The OM Collector process is shutting down.

i __________________________________}
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Upgrading the MG 9000

This section provides a description of the upgrade process and the
software upgrade tool in the MG 9000 Manager used to upgrade
software in the cards in the MG 9000. The following procedures for
upgrading the MG 9000 are included in this section:

¢ |nstalling MG 9000 loads into the CS 2000 Management Tools
Manager from CDROM on page 60

e Deliver and install MG 9000 loads using Electronic Software
Delivery on page 63

* Provisioning a floating IP address on page 70

* information on the process and tools used to upgrade software in
the MG 9000 cards

— Upgrading software in MG 9000 cards on page 73

— Software Upgrade View on page 75
— Software upgrade errors and problem resolution on page 82

— Upgrade Wizard overview on page 88
* upgrade procedures by type

— Card upgrade with user intervention on page 99

— Card upgrade without user intervention on page 104

— MG upqgrades on page 108

e Downloading software into the MTA card on page 110
* Downloading software into the xDSL card on page 112
e Upgrade history on page 114

e Patching the MG 9000 on page 117
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Installing MG 9000 loads into CS 2000 Core Mgr from CDROM

Purpose of this procedure

This procedure describes how to install the MG 9000 software loads
onto the CS 2000 Core Manager (SDM) from CDROM.

When to use this procedure

This procedure is to be used when a Maintenance Non-computing Load
(MNCL) software release or standard NCL is delivered to the customer
site.

Prerequisites

When supporting an upgrade from SN06.2 or SNO7 to SNO8, ensure
the SN06.2 or SNO7 loads are currently in the SDM/CBM in the event
there is a need to perform a software downgrade from SNO8 to SN06.2
or SNO7.

Action

Installing MG 9000 loads into the CS 2000 Management Tools
Manager from CDROM

At the CS 2000 Management Tools Manager

1 Insert the CDROM into the CDROM tray. If the unit is a Netra 240
in a cluster configuration, use the active Netra 240 unit. The
active unit is identified by a lit USER LED on the front of the unit.

The CDROM label for the SAM21 Shelf Controller software
includes the product code, MG9K0080, on the lower half of the
label.

At the CS 2000 Management Tools console or terminal window

2 Log in and then use the su command to gain root privilege.

login: username

Password: <password>

Last login: Fri Jun 30 12:48:18 from <otherhost>
su - root

Password: <password>

3 Execute the platform_load_install.sh script by typing

# /opt/nortel/sspfs/Scripts/platform load inst
all.sh
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The system responds with the following.

Welcome to the Platform Installation Tool
Version 3.2

1) Install RPM from CDROM 2) Install RPM from
Disk
3) Uninstall RPM 4) Query all RPMs

C) Change Rotation Parameters P) View Rotation
Parameters

V) MG9K Platform Version X) Exit

Installed

Please choose one of the following:

To install the software type 1 and press the Return key.

The screen clears and the contents of the .rpm package are
displayed.

Note: If the message There is no cd in the CDROM
drive, please check driveisdisplayed, ensure thatthe
CDROM is inserted in the tray for this unit.

To proceed with the software installation, type Y.

The software is extracted from the .rpm package. The .rpm
package is transferred to the CS 2000 Core Manager.

Enter the root password for the CS 2000 Core Manager. The
software is installed on the CS 2000 Core Manager.

Enter the Eject command to eject the CD from the CDROM
drive.

# eject
Log out of the CS 2000 Management Tools server.

Change the ownership of all files in the /swd/mg9k directory to
imaging userid by performing the following steps:

a Login as root to the SDM/CBM as root.
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b Change ownership recursively of the /swd/mg9k directory by
typing

# chown -R <imaging userid>:<userid group>
/swd/mg9k

where
imaging user id is the user id for the image server

userid group is the group to which the userid belongs
¢ Log out of the SDM/CBM.
10 Remove the CDROM.

11 This procedure is complete.
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Deliver and install MG 9000 loads using Electronic Software Delivery

Purpose of this procedure

This procedure describes how to transfer MG 9000 software loads from
Nortel Networks to a customer drop box using the Electronic Software
Delivery (ESD) method, and how to install the transferred load onto the
CS 2000 Core Manager.

Note: For information on how to install MG 9000 load from
CD-ROM, refer to procedure Installing MG 9000 loads into the CS
2000 Management Tools Manager from CDROM on page 60.

When to use this procedure

Use this procedure after receiving electronic notification for the
following software loads:

e MG9KC0080.n.V.NCL.NAP.VAULT.nn.D.tar.gz - for standard NCL
release

e MG9KWO0080.n.V.NCL.NAP.VAULT.nn.D.tar.gz - for standard
International NCL release

e MG9KOMO080.n.V.NCL.NAP.VAULT.nn.D.tar.gz - for maintenance
(MNCL) release

where

n
is an integer value such as 7 and is part of the product order code

vault
is a string that identifies the Nortel Networks software vault that
holds the software

nn
is an integer value that indicates the repository version of the
software

Prerequisites

Your operating company must have an ESD agreement with Nortel
Networks. When the agreement was established, the operating
company furnished Nortel Networks with the location of an electronic
drop box and a user name and password pair for delivering software
loads. When Nortel Networks delivers a software load to the drop box,
an electronic mail notification is sent to the e-mail address specified by
the telephone operating company when the ESD agreement was
established.
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Action

At a CS 2000 Management Tools server terminal

1

Make a temporary directory to store the ESD software by typing
$ mkdir /data/iso_esd

and pressing the Enter key.

Change directory to the newly created location by typing

$ cd /data/iso_esd

and pressing the Enter key.

Ensure that enough disk space is available for the ESD software
(500 MByte is recommended) by typing

$ df -k /data
and pressing the Enter key.

The free space on the device that /data is mounted is printed.
The value for “avail” is the number of free kilobytes. Divide that
number by 1000 to determine the number of free megabytes.

s df -k /data

Filesystem
/dev/md/dsk/d20

.

kbytes used avail yapacity Mounted on
3082223 144125\ 2876454 5% /data

2876454 / 1000 = 2876 MB free

/

Transfer the ESD software files from the drop box on the
repository server by typing

$ ftp <repository server>
and pressing the Enter key.
where

<repository_server>
is the machine owned by the telephone operating company
that was selected to be the destination for the ESD
software files

Log in and change directory to the drop box location on the
repository server.
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5 Change the transfer mode to binary by typing
ftp> bin
and pressing the Enter key.

6 Retrieve the ESD software load by typing
ftp> get <esd filename>.tar.gz
and pressing the Enter key.
where

<esd_filename>
is the ESD filename for the MG 9000 software load

Example
ftp> get MG9KC0080.70.V.NCL.NAP.VAULT.8.D.tar.gz

Note: Determine the actual ESD filename from the Nortel
Networks notification, or by listing the contents of the drop box
with the Is command.

7 Repeat step 6 for all ESD software loads recorded in the
notification from Nortel Networks.

8 End the FTP session by typing
ftp> bye
and pressing the Enter key.
9 Extract the ESD software load from the tape archive format by
typing
$ gtar xvzf <esd_filename>.tar.gz
and pressing the Enter key.
where

<esd_filename>
is the ESD filename for the MG 9000 software load

Example
$ gtar xvzf MG9KC0080.70.V.NCL.NAP.VAULT.8.D.tar.gz

The ESD software load is uncompressed, and a new directory
named after the ESD software filename is created. The directory
name is the name of the ESD filename without the .tar.gz suffix.
The contents of the ESD software load are placed in this new
directory.
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10 Access the newly created directory by typing
$ cd <esd_filename directory>
and pressing the Enter key.
where

<esd_filename_directory>
is the new directory created to store the extracted software
load

Example
$ cd MG9KC0080.70.V.NCL.NAP.VAULT.8.D

11 Become the root user by typing
$ su - root
and pressing the Enter key.
12 When prompted, enter the root password.

13 The ESD software is formatted as an 1ISO 9660 image. Mount
the 1ISO 9660 image (using the mount_iso.ksh script) by typing

# /opt/nortel/sspfs/Scripts/mount iso.ksh mount
/data/iso_esd/<esd_directory>/<iso_image>.img.
tape

and pressing the Enter key.
where

<esd_directory>
is the directory created in step 9

<iso_image>
is the name of the iso image

Note: A space is required after the word mount and before
the word /data.

Example

# mount_iso.ksh mount
/data/iso_esd/MG9KC0080.70.V.NCL.NAP.VAULT.8D/
GNO070_load.iso.tape
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A response is printed to the terminal. Use following table to
determine if the command was successful.

mount_iso.ksh command responses

Response

Meaning and action

Is is very important for the
user of this command to know
that if you mount an iso image.
It is a MUST that you umount an
image before removing the
image file. If the file is
deleted while the 0S has it
mounted, it can be harmful to
the runtime applications on
this unit

Provided full path to ISO image
does not exist

ISO Image Already Mounted

Error creating the image
device location

ERROR MOUNTING <ESD_filename>

This response indicates success.

Verify the location and name of the

ISO 9660 image, such us
/data/iso_esd/MG9KCO008.../...img.tape,
and retry.

Enter mount_iso.ksh umount to
unmount whatever ISO 9660 image is
currently mounted, and retry.

This response indicates an operating
system error with the loopback file driver.
Retry the command, and if it fails a
second time, contact Nortel Networks
support personnel.

This response indicates that either the
ISO 9660 file is corrupt, or the
/tmpmnt/noarch directory has been
deleted.

The contents of the ESD software file are available in directory
/tmpmnt /noarch.

14 Use the following table to determine your next step.

If you want to install the software Do

later

now

go to step 15
go to step 16
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15

16

Copy the contents to a location on the CS 2000 Management
Tools server by typing

# cp /tmpmnt/noarch/*.* <directory_name>
and pressing the Enter key.
where

<directory_name>
is a directory on the CS 2000 Management Tools server,
for example /data/iso_esd

Note: Ensure that you have write permission to this directory,
and that the same file permissions are set at the old and
copied locations.

When installing the software at the later date, complete step 16,
but in sub-step e, specify the new location of the software
instead of typing tmpmnt/noarch.

Continue with step 17.

Complete the following steps to install the software on the
CS 2000 Core Manager.

a List the contents of the /tmpmnt/noarch directory by typing
# ls /tmpmnt/noarch
and pressing the Enter key.
Record the name of the .rpm file.
b Execute the installation script by typing
# platform load_install.sh
and pressing the Enter key.

¢ When prompted, select the option "Install RPM from Disk" by
typing
> 2
and pressing the Enter key.

d When prompted, enter the .rpm filename and press the Enter
key.
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17

18

e When prompted, enter the location of the .rpm file by typing
# /tmpmnt/noarch
and pressing the Enter key.

The system installs the software on the CS 2000 Core
Manager.

After the load file is installed on the CS 2000 Core Manager,
the transferred .rpm package is deleted from the CS 2000
Core Manager.

f Exit the installation program by typing
# X
and pressing the Enter key.

Unmount the ESD file by typing

# mount_iso.ksh umount

and pressing the Enter key.

This procedure is complete.
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Provisioning a floating IP address

Purpose of this procedure
The MG 9000 Manager assigns the floating IP address to the card
being upgraded dynamically. The floating IP address is provisioned
from the MG 9000 Manager as described in the following procedure.
Provisioning a floating IP address should be performed during initial
installation and commissioning. The floating IP address is persisted in
the MG 9000 Manager data.

Note: Before beginning, ensure you have the correct privileges to
perform this procedure.

Contact your network administrator to obtain a new IP address when a
new floating IP address must be provisioned.

When to use this procedure

This procedure is provided only if the need arises to change, correct, or
add the floating IP address.

Prerequisites
There are no prerequisites.

Action

Provisioning a floating IP address

At the MG 9000 Manager

1 Verify whether a floating IP address has already been
provisioned at the MG 9000 Manager by selecting
Services->Floating IP Address Manager from the menu bar of
any Frame, Shelf, or Card View. This address must be in the
same subnet as the MG 9000.

2 To provision a floating IP address in the MG 9000 Manager if
necessary, perform the following steps:

a From any Frame, Shelf, or Card view select the menu
Services. From within Services select Floating IP Address
Manager, as shown in the following figure.
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i

Floating IP Address Manager accessed from Shelf View

W1 === T

e o
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b Enterthe IP addressin the Floating IP Address Manager and
select Apply. The address will be displayed under existing IP
addresses. When finished, select Close.

Floating IP Address Manager View

£ Floating IP Address Manager [ = IEIIE[

P SE000

~Existing Addresses———— Create a new Floating IP-

Delete the selected address:

Flaating IP Address: | |- | | | | | |

Appli(‘ Refresh Close

¢ If the floating IP address must be replaced, delete the entry
first. To delete an entry select the entry, select the Delete
check box, then press Apply. When finished select Close.

d |If the floating IP address is correct, select Close.

3 This procedure is complete. If this is part of an upgrade, return
to the upgrade checklist to continue with the upgrade process.

e
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Upgrading software in MG 9000 cards

This section provides an overview of upgrading software in MG 9000
cards.

The MG 9000 Manager provides tools for upgrading software in
MG 9000 cards to upgrade the software in the following intelligent cards
in the MG 9000:

e data control card (DCC)

— OC-3

— DS1-IMA

— Gigabit Ethernet (GigE)
e Internet telephony extender (ITX) card
* Internet telephony processor (ITP) card
e DS-512 Access Bridging Interface (ABI) card
e DS1 card (not used in UA-IP solution)
e metallic test access (MTA) card
* x digital subscriber line (xDSL) card
The Software Upgrade Wizard supports two types of upgrade:
Complete Upgrade or Downl.oad only. The following cards only use the
Software Upgrade Wizard when a Complete Download is selected from
the MG Upgrade Wizard. Otherwise, each card must have the software
downloaded into it individually using the Software Download tool

accessed from the card view for each card. The software download
procedures for these cards are provided later in this document.

e MTA card
e xDSL card

The software upgrade consists of the following four steps:

1. Configure - The configuration parameters are entered in a Card
Upgrade Wizard or MG Upgrade Wizard described later.

2. Download - The MG 9000 is requested to download the software
load to a card or cards based in the parameters configured in the
previous step. The load is downloaded and stored in flash memory.
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3. Apply - The software load is installed. A restart is performed in the
card.

4. Accept - The new installed load is made the primary load. The user
can no longer revert to the old load unless a complete downgrade
is performed.

An additional Abort step can be used to abort an upgrade in progress,
an revert back to the old load.

Note: Software upgrade of cards in the MG 9000 must be performed
in the following order DS1, ABI, ITP, ITX, DCC.
There are two ways to perform a software upgrade.

e with user interaction - The user must enter separate commands to
perform the download, apply, and accept steps.

* without user interaction - The user enters a single command to
perform the download, apply, and accept steps.
Upgrade version rules

The software upgrade application requires the following version order
when an upgrade is performed to a load with the same version or to
higher version load.

e DS1 or ABI
e ITP

e ITX
 DCC

Note 1: When itis necessary to downgrade to SN06.2 or SNO7 from
SNO08, perform procedure Downgrading the MG 9000 and MG 9000

Manager from SN0O8 to SN06.2 or SNO7 on page 32.

Note 2: During a downgrade, attempting to upgrade cards to a
version lower than the DCC card is not supported.

Upgrades - the supported upgrade path for the MG 9000 is from SNO7
to SNO8 for the UA-IP solution and from SN06.2 or SNO7 to SN08 for
the UA-AAL1 solution.

Downgrades - the supported downgrade path for the MG 9000 is from
SNO08 to SN06.2 or SNO7 for UA-AAL1 and SNO8 to SNO7 for UA-IP.
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Software Upgrade View

This section provides an overview of the Software Upgrade tool in the
MG 9000 Manager.

The software upgrade is performed using the Software Upgrade tool.
The Software Upgrade tool is accessed from the MG 9000 Manager.
When accessed, the Software Upgrade View appears. The Software
Upgrade view is accessed from the

» Card View for upgrading a single card, protection group, or all cards
of the same type

* Frame View for upgrading multiple card types

The following figure shows accessing Software Upgrade from the
Actions pull-down menu from the Card View

Software upgrade accessed from Card View (ITX Card view
shown)

T Card: NE-1 Frame-1 Shelf0 Slat-14 -
G000 | Actions

Software Upgrade.t\\s =]
Software Image. .
A VACADOBAAA
- faintenance b
Manage Thresholds Martel MGSk ITX Card
Hardware Yersion: 2 200244

The following figure shows accessing Software upgrade from the
Actions pull-down menu from the Frame View.

Software upgrade accessed from Frame View

MGI000 Element 1
MGI000 | Actions

Frovision Frarme Location Information. ..

Software Upgrade. . [%
oave SLOA sevices
Save PLOA services
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The Software Upgrade view contains the following four panels

* Upgrade Originator panel - displays the name and number of the
MG 9000 where the upgrade is taking place and the location of the
view from which the upgrade command was invoked. In addition,
The Originator field indicates whether the upgrade is being
controlled from the GUI or the CLUI.

* Upgrade State - displays text fields with information about an
upgrade in progress which includes the status and the action being
performed or just completed. The action and upgrade type fields are
updated when the upgrade request is confirmed. The upgrade
status is updated as upgrade steps are performed.

* Upgrade Type Data - displays data used to perform the upgrade.
The text fields in this panel are updated when the configure step is
completed. When the upgrade is for a single card type, protection
group, or single card it includes text fields for the cards being
upgraded, the load server, the user identifier that is used to access
the load server, and the full path to the load name. The text field
upgrading indicates the cards being upgraded as follows

— For a single card upgrade, this field displays the location of the
card being upgraded.

— For an active/inactive pair of mate cards, the shelf location
followed by the two slot numbers is displayed.

— For a card type upgrade, the card type being upgraded is
indicated.

* Upgrade Instructions & Results - displays the results of an upgrade
step and instructions for the next step to perform

Seven buttons are provided in the lower area of the view to enable the
user to perform commands. The buttons are described in the following
table.

Software Upgrade View buttons and descriptions

Button Description

History This button creates a new view that shows the upgrade history for the
given MG 9000. Refer to Upgrade history on page 114.

Refresh This button updates the Software Upgrade View.

NN10048-461
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Software Upgrade View buttons and descriptions

Button

Description

<upgrade
step>

Version
List

This is the second button from the left. This button is used to perform an
upgrade step. It changes its label depending on the next step to be
performed. It is greyed out when the step is no longer valid.

The labels assumed by this button are described as follows:

e Configure - The upgrade step button is set to this label when the view
is first created, and after an abort is completed.

— When pressed on the Software Upgrade accessed from the Card
View, the Card Upgrade Wizard is created.

— When pressed on the Software Upgrade accessed from the
Frame View, the Upgrade Type Selection panel is created.

See section Upgrade Wizard overview on page 88. If another user is
performing a software upgrade, a message is output indicating the
tool is in use and the Configure button is disabled.

* Upgrade - The Upgrade step button appears when an upgrade
without user interaction is chosen. This step accomplishes the
actions described in the following three buttons that appear when
user interaction is selected.

The following labels appear when user interaction is selected:

* Download (not applicable to the Software Upgrade accessed from
the Frame View) - The upgrade step button is set to this label when
the upgrade wizard finishes the configuration for an upgrade with
user interaction. When pressed, the MG 9000 is requested to perform
a download. The parameters provided by the upgrade wizard are
sent to the MG 9000 in the download request.

* Apply (not applicable to the Software Upgrade accessed from the
Frame View) - The upgrade step button is set to this label when the
MG 9000 completes the download step successfully. When this
button is pressed the MG 9000 is requested to apply the load to the
card previously downloaded.

* Accept (not applicable to the Software Upgrade accessed from the
Frame View) - The upgrade step button is set to this label when the
MG 9000 completes the apply step successfully. When this button is
pressed, the MG 9000 is requested to accept this load as the primary
load.

View all versions of the cards.
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Software Upgrade View buttons and descriptions

Button

Description

Abort

Close

Retry

This button is used to request the MG 9000 perform an abort. The button
is enabled when an upgrade without user interaction is executed, and
when the download step for an upgrade with user interaction is
performed. It remains enabled until an abort is initiated or the accept step
of the upgrade is initiated. In certain situations, such as when a fault on
a card cannot be corrected, the MG 9000 cannot abort and revert back
to the old loads. If the abort fails and there is no other way to stop the
upgrade, use the Reset Upgrade System command located on the
MG9000 History view (refer to Upgrade history on page 114).

This button is used to close this view. It is disabled while the upgrade is
in progress. The button is enabled when an accept or an abort step is
completed.

An upgrade view can also be closed by the Close command in the
window menu. A Close command is also provided in the MG 9000 menu.
For the last two cases the Close command is not disabled when an
upgrade is in progress.

This button is enabled only if a step in the upgrade process fails. Retry
is used to continue an upgrade action from the place where it stopped
after the customer has corrected the problem.

NN10048-461
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Software Upgrade View accessed from Card View

MG 8000 Software Upgrade Element: 1 &
MG3000

~Upgrade Originator

MG 9000 Name: YOIP10 1 |

Orriginating Yiew: |GUI: [T Card: NE-1 Frame-1 Shelf0 Slot-14 |

~Upgrade State:

Upgrade Status: |Waiting for Configure. |

Upgrade Action: | |

Upgrade Type: | |

~Upgrade Type Data:

Upgrading:

Load Serer User Id:

| |
Load Semer: | |
| |
Load: | |

~Upgrade Instructions & Results:

Press Configure to invoke the Upgrade Configuration Wizard,
Or press Yersion List to see all the versions of the cards.
Orr press History to see the results of previous upgrades.

Histary ‘ | Refresh | ‘ Configure | ‘ “ersion List ‘ ‘ Abort ‘ ‘ Retry ‘ ‘ Close ‘

When performing an upgrade of multiple card types, from the Frame
View of the MG 9000 to be upgraded, select Actions->Software
Upgrade. The Software Upgrade View accessed from the Frame View
appears as shown in the following figure.
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Software Upgrade View accessed from Frame View

MG 3000 Software Upgrade Element: 1
MGI000

~Upgrade Originator

MG 8000 Mame:  “OIP10 1 |

Originating View: GUI: MGS000 Element 1 |

~Upgrade State:

Upgrade Status: |Waiting for Configure. |

Upgrade Action: | |

Upgrade Type: | |

~Upgrade Type Data:

Upgrading: |

Load Semer: |

|
|
Load Server User |d: | |
|

Load: |

~Upgrade Instructions & Results:
Press Configure to invake the Upgrade Configuration YWizard.
Or press Version List to see all the versions of the cards.
Or press History to see the results of previous upgrades.

‘ History | | Refresh | ‘ Configure | ‘ “ersion List ‘ | Ahort ‘ ‘ Retry ‘ ‘ Close ‘

The following figure shows the Subnet View with the download icon on
top of the MG 9000 on which a software download is in progress. The
download icon also appears at the card and shelf views. The icon
remains until the upgrade is complete or an abort completes.

= R —————I——
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Subnet View showing download icon

£ Nortel Networks Subnet Yiew for SNO8@rtpsmg9kem.us.nortel.com {CM_CLLL: rtps)
File Configuration Alarm  Performance  MGS000 Help

% 3 Subnet : O
[y PiE1 [12] : 12— 12— AR~ I
[y pist (1]
%E:ﬁ E FIET (2] FIFAT T PIT21[6] PITT [5] VOIP13 [3]
[y voIiP13 3]
[y voir1z2 2]
[y woirez [4]
[ voiPia 1] VOIP12 [2] VOIPE2 [4] VOIP10 [1]

The following figure shows the version list that appears in response to
selecting the Version List button on the Software Upgrade View. The
version list shows all common cards on the selected MG 9000 and the
software version of the loads in the card.

Version list

Downloadable Equipment Yersion List
M ES000

Card Type | Location | “ersion |
Supercore OC3 Card ME Mumhber: 1 ME Mame: %0IP10 PhysLoc: 10 11 0z 0
Supercare OC3 Card ME MNumber: 1 ME MName: %OIP10 Physloc: 1010 0z 0
YDEL Card ME Mumber: 1 ME Mame: YOIP10 Physloc: 108 0s 2
MTA Card ME Number: 1 ME Mame: ¥OIP10 Physloc: 112 0s 0
HDESL Card ME Mumber: 1 ME Mame: YOIP10 PhysLoc: 1016 0 2
ITX Card ME Mumber: 1 ME Mame: Y¥OIP10 Physloc: 1015 0s 0
ITP Card ME Mumber: 1 ME Mame: YOIP10 PhysLoc: 1113 03 0 i
ITX Card ME Mumber: 1 ME Mame: YOIP10 Physloc: 1014 05 0 |
ITP Card ME Mumhber: 1 NE Mame: %0IP10 PhysLoc: 1112 08 0 =

Refresh Close
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Software upgrade errors and problem resolution

The following table lists the errors that may arise at various steps in the

MG 9000 software upgrade process, the cause, and recovery actions.

MG 9000 software upgrade errors and problem resolution

Error type

Cause

Recovery action

Invalid file type

Invalid Version

Invalid State

Upgrade provisioning errors

This error is received if
the card type selected is
invalid for the load file
name provided. Every
load file name has the
card type embedded
within it.

This error is received if
the version number
embedded within the
load file name is invalid
for this gateway. For
example, if it is only
valid to upgrade to
versions 5 or 6 and the
loadfile name contains
version 8, an error is
displayed.

This card is locked or
active.

Ensure the load file name is valid for the
card type to be provisioned, then try
again.

Ensure the load file name version is
valid for the attempted upgrade, then try
again.

If this card is active and does have a

mate, the request will be denied. First
Swact/Spare the card to its mate and
continue.

If this card is inactive, but locked, first
unlock the card and continue.

NN10048-461
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MG 9000 software upgrade errors and problem resolution

Error type

Cause

Recovery action

Download errors

Apply will fail if this card
has a mate.

FTP server Possible causes: Abort the upgrade. Check provisioned
related e incorrectSDM Satarggrevalldlty and provision another
loadfile/path Pg :
permissions
e floating IP
configuration error
* network connection
failure identified
during the
provisioning activity
Corrupt File This error may be due Abort the upgrade.
to: e For the incompatible load file error,
* provisioning an check the file name type and
incompatible load provision another upgrade.
file for this card. For : -
. ; * For the insufficient memory error, go
![ns’gl?scleT,g tpheeclzgg% to dshell and do a filesys/finfo and
fﬁg name must look a the freespace on the volume.
include ITP. The It should be about three times the
same is true for size of the image file.
other cards.
e insufficient memory
for an image file
Node Not The card may be Go to the Card View and verify the card
Responding undergoing a status, if the card status appears correct
maintenance operation  the error may have been due to an
or is in an otherwise longer than expected communication
invalid state (such as, delay. Abort the upgrade and try again
restarting) or may not be
running.
Apply errors
State If this card is Active, an  Abort the upgrade. Cause a redundancy

action (Swact or Spare) to occur. This
card may have been Inactive during the
provisioning of the upgrade. A
redundancy action may have occurred
which would be the reason the card is no
longer Active.
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MG 9000 software upgrade errors and problem resolution

Multi-Node Only

SwactMateState
Multi-Node Only

SwactMateUnav
ailable

Multi-Node Only

protection group are
NOT in data sync, a
required Swact has
failed or will not be
executed

For reasons other than
not in DataSync, the
Active card refuses to
give up activity (possibly
due to faults on the
inActive card).

A communication
problem exists between
the Inactive and the
Active cards. A Swact is
not allowed.

Error type Cause Recovery action

Node Not This card may be Go to the Card View and verify the card

Responding undergoing a status, if the card status appears correct
maintenance operation, the error may have been due to an
isin an otherwiseinvalid longer than expected communication
state (such as, delay. Abort this upgrade and try again
restarting) or may not be
running.

SwactDataSync Mate cards in a Go to the Card View and lock the card,

then go to the Card View for the Inactive
mate and unlock the card. The unlock
action will cause a restart (since they are
not in data sync).

Once the Inactive card has completed
its restart, attempt to Abort.

Note: If after multiple tries data sync is
not achieved, contact Nortel Networks
for further guidance - additional
upgrades are not possible until this is
resolved.

Determine what the fault state or
problem with the inActive card is and
correct it.

Once the inActive card is in a valid state,
you may then again attempt to Abort.

Note: If you cannot correct the error,
contact Nortel Networks for further
guidance - additional upgrades are not
possible until this is resolved.

Resolve the communication problem.

Once the Inactive card is in a valid state,
attempt to Abort.

Note: If you cannot correct the error,
contact Nortel Networks for further
guidance - additional upgrades are not
possible until this is resolved.
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MG 9000 software upgrade errors and problem resolution

Error type

Cause

Recovery action

SwactError
Multi-Node Only

Generic

A generic error
associated with a Swact
request, but enough
information cannot be
obtained for the
Upgrade subsystem to
identify the cause.

See Above

Contact your maintenance administrator
to identify and resolve the problem.

Once the card(s) are in a valid state,
attempt to Abort.

Note: If you cannot correct the error,
contact Nortel Networks for further
guidance - additional upgrades are not
possible until this is resolved.

Contact Nortel Networks.

Accept errors

Node Not
Responding

GENERIC

The card may be
undergoing a
maintenance operation,
is in an otherwise invalid
state (such as
restarting) or may not be
running.

See Above

Go to the Card View and verify the card
status, if the card status appears correct
the error may have been due to an
longer than expected communication
delay. Abort the upgrade and try again

Contact Nortel Networks.

Abort errors

Node Not
Responding

The card may be
undergoing a
maintenance operation,
is in an otherwise invalid
state (such as
restarting) or may not be
running.

Go to the Card View and verify the card
status, if the card status appears

correct, the error may have been due to
an longer than expected communication
delay. Abort this upgrade and try again.
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MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action
SwactDataSync Mate cards in a Go to the Card View and lock, then go to
protection group are the Card View for the inActive mate and

NOT in data sync, a unlock the card. The unlock action will

required Swact has cause a restart (since they are not in

failed or will not be data sync).

executed Once the inActive card has completed
its restart, you may then again attempt
to Abort.

Note: If after multiple tries data sync is
not achieved, contact Nortel Networks
for further guidance - additional
upgrades are not possible until this is
resolved.

SwactMateState For reasons other than  Determine what the fault state or

not in DataSync, the problem with the inActive card is and

Active card refuses to correct it.

give up activity (possibly : - :

due to faults on the gt?ecri”t}?olr,lb‘%%lr\tle card is in a valid

Inactive card). P '

Note: If you cannot correct the error,
contact Nortel Networks for further
guidance - additional upgrades are not
possible until this is resolved.
SwactMateUnav There is a Resolve the communications issue
ailable communication problem . ‘ot .
between the Inactive ;)n:iﬁ tgt?elgac;t{\éeisgﬂ is in a valid state,
and ch[ive cards. A 9 P )

Swact is not allowed. Note: If you cannot correct the error,
contact Nortel Networks for further
guidance - additional upgrades are not
possible until this is resolved.
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MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action

SwactError This is a generic error Contact your maintenance administrator
associated with a Swact to identify and resolve the problem.
request, but enough , ,
information cannot be g?ecri t??ocﬁgé(rst) are in a valid state,
obtained for the P '
Upgrade subsystem to

identify the cause. Note: If you cannot correct the error,

contact Nortel Networks for further
guidance - additional upgrades are not
possible until this is resolved.

GENERIC See Above Contact Nortel Networks
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Upgrade Wizard overview

NN10048-461

This section provides an overview of the upgrade wizard which is
accessed from the Software Upgrade View.

The Software Upgrade View contains the following text fields:

* MG 9000 Name - provides the name and number of the MG 9000
selected for upgrade

e Originating view - provides the frame view of the MG 9000 view from
which the software upgrade request has been originated

* Upgrade status - is set to Waiting for Configure

* All other fields are blank and then updated when the configuration
step is completed and the Configure button is enabled. The user is
instructed to perform the Configure step in the Upgrade Instructions
& Results texts area. The following figure shows the Software
Upgrade View.

Software Upgrade View

MG 5000 Software Upgrade Element: 1 ¢
rG2000

~Upgrade Originat
MG 9000 Name: WOIP10 1

Criginating “iew: GUI: MG2000 Elerment 1

rUpgrade State:
Upgrade Status:  Waiting for Configure.

Upgrade Action:

Upgrade Type:

~Upgrade Type Data:
Upgrading:
Load Server:
Load Server User |d:

Load:

~Upgrade Instructions & R
Press Configure to invoke the Upgrade Configuration Wizard.
Or press Yersion List to see all the versions of the cards.
Or press History to see the results of previous upgrades.

e
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After clicking Configure, the Upgrade Wizard appears. The upgrade
wizard is available in two forms, Card Upgrade Wizard and MG
Upgrade Wizard, depending on how it was accessed. These two are
described in the sections that follow.

Card Upgrade Wizard

This section provides an overview of the Card Upgrade Wizard. The
Card Upgrade Wizard is accessed from the individual card view by
selecting Actions->Software Upgrade from the menu bar and clicking
on Configure in the Software Upgrade View.

The upgrade wizard consists of four panels. Each panel is a step in the
card upgrade wizard and all steps are discussed next.

The first Card Upgrade Wizard step (step 1) allows the user to
specify the upgrade type by clicking on the pull down. The following
three upgrade types are available:

— card type - upgrade the individual card from which this panel was
launched

— protection group - upgrade the card from which this panel was
launched and its redundant mate (though this option is available
in the Card upgrade wizard, it is recommended that upgrades of
a protection group be performed using the MG Upgrade Wizard

on page 94.)

— all cards of this type - upgrade all cards of the selected type in
the MG 9000 (though this option is available in the Card upgrade
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wizard, it is recommended that upgrades of all card of a given
type be performed using the MG Upgrade Wizard on page 94.)

The upgrade procedures for protection group and all card type
upgrades are similar to the upgrade procedures for single card
upgrades. The difference are:

— upgrading of multiple cards instead of a single card with upgrade
icon appearing on all cards being upgraded

— Swact occurs without user intervention as part of the upgrade

Card Upgrade Wizard, Step 1

= Card Upgrade Wizard: YOIP10 1 =]
Card Upgrade for ITX: Step 1 of 4

Specify the upgrade type for this card. Select either single card,
protection group, or all cards of this type.

Selected Card:  |ITX

Select an upgrade type: | Upgrade this card - |

| Mext H Cancel |

* The next Card Upgrade Wizard step (step 2) allows the user to enter
a load server IP address, a userid and password to be used to
access the load server. The last six entries for the server |IP address
are remembered. The user can select between the last six entries
or enter anew one. The user is not allowed to move to the next panel
until all the entries on this panel are completed with valid data. If the
entered |IP address, userid, or password are not valid, an error
message appears and the user must correct the entry for the
upgrade process to proceed to the next step. The following figure
shows the Card Upgrade Wizard, Step 2.
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Card Upgrade Wizard, Step 2, select a load server

< Card Upgrade Wizard: ¥OIP10 1

Select a load server for ITX: Step 2 of 4

Please enter a new load server address or select from existing addresses. Also,
specify a user identifier and password for the selected semer.

Server Address: w7.1428950 ||

Server User [dentifier: | |

Server Passwaord: | |

‘ Previous || e xt H Cancel |

* The next panel (step 3) allows the user to enter the directory and
load name to be used for the upgrade. If the entered directory is
incorrect, a message appears to inform the user and the directory
must be corrected for the upgrade to proceed.

Click on the List button to retrieve the files from the load server and
the combo box is populated with MG 9000 patched image (9PI) file
names (identified by the .tar extension on the filename). Choose a
file from the list. The following figure shows Step 3 of the Card
Upgrade Wizard.

Card Upgrade Wizard, Step 3, specify a load

‘i MG Upgrade Wizard: co8 8 | . |J|

Specify a load for DS1: Step 3 of 3

FPlease specify a software load directory and load narme

Directory: [fpubfloads/mgdSHOE | v| List

Load Marne: | DS1 058P . gz - |

DS1GOEEP . g=
DS1GOEEP_GZ tar

Remove Entries || Previous | Gancel || Finish

e The next panel (step 4) prompts for the user to select between
performing the upgrade with user interaction or without user
interaction. The following figure shows Step 4 of the MG Upgrade
Wizard.
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% Card Upgrade Wizard: voipZ 2 [ _ O]
Interactive Download: Step 4 of 4
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Card Upgrade Wizard, Step 4, interactive download

Specify user interaction rmode:

i® Perform upgrade with user interaction.

i3 Perform upgrade without user interaction.

Previous i ‘ Cancel || Finizh ‘

— Perform upgrade without user interaction - It is recommended

that this mode is used. When selecting this mode, after the user
clicks Finish, the system responds with an Upgrade button on
the Software Upgrade View. After the user clicks Upgrade, the
system continues with the successful completion of each action,
the next action automatically executes without any input needed
from the user. The exception to this, is if an error occurs. Then
the upgrade stops and the user must click Abort. Error
messages will be output. Refer to Software upgrade errors and
problem resolution on page 82for information on responding to
errors.

Perform upgrade with user interaction - When selecting this
mode, the system responds with a Download button on the
Software Upgrade View. The system then prompts for an Apply
followed by an Accept. Like the previously discussed upgrade
without user interaction, refer to Software upgrade errors and
problem resolution on page 82 for information on responding
any errors that may occur.

Note 1: If a “Protection group” or “All cards of this type”
upgrade is selected, during the Download action/phase of the
upgrade, only one designated card gets the new software from
the load server. All other cards involved with the upgrade get
the new software from that card.

Note 2: If a “Protection group” or “All cards of this type”
upgrade is selected, during an upgrade, a controlled, non-user
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requested Swact occurs. The system raises redundancy
notifications as normal while Apply action is occurring, only an
encountered error terminates its progress.

The user interaction is as follows:

Apply - After the system successfully completes the
Download, the system prompts the user to click Apply. Apply
causes the card to restart. After the restart has completed,
the card will be executing the new, upgraded software. An
automatic SWACT and restart of the mate occurs as part of
the Apply action. (Not applicable to single card upgrades.)

Accept - After the system successfully completes the Apply
the system prompts the user to click Accept. Accept causes
the card to complete its upgrade activity which takes a few
seconds. The system notifies the user when the Accept is
completed. Exit the upgrade view by pressing Close. Verify
the upgrade is complete by viewing History.

* After clicking Finish, the Upgrade Wizard disappears and the
Software Upgrade View prompts the user to click Download (with
user interaction) or Upgrade (without user interaction) to start the
upgrade process. Upgrade progress is reported in the Upgrade
Instructions & Results window of the Software Upgrade View.
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MG Upgrade Wizard

NN10048-461

This section provides an overview of the MG Upgrade Wizard. The MG
Upgrade Wizard is accessed from the Frame View by selecting
Actions->Software Upgrade from the menu bar and clicking on
Configure in the Software Upgrade View.

The upgrade wizard consists of multiple steps (panels), depending on
the actions chosen in step 1. Each panel is a step in the MG Upgrade
Wizard and all steps are discussed next.

* The first MG Upgrade Wizard step (Step1) allows the user to select
the upgrade type: complete upgrade or just download the loads prior
to an upgrade. As noted in the GUI,

— Complete Upgrade - the MG 9000 Manager downloads the
loads to all the cards, if needed, and being the cards up and
running on the new loads. This option should be performed
during a maintenance window only.

— Download Only - the MG 9000 Manager downloads the loads to
all the cards but the cards continue to run on their existing loads.
This option can be performed at any time.

MG Upgrade Wizard, Step 1, upgrade type selection

< MG Upgrade Wizard: ¥DIP10 1 M=l 3
Upgrade Type Selection: Step 1 of many.

Do you want to perform a complete upgrade or just download the loads prior to upgrade?

If you select the option 'Complete Upgrade', the EM will download the new loads to all the cards
{if needed), and bring the cards up and running on the new loads. This option should be performed
during a maintenance window only.

If you select option ‘Download Only', the EM will download the new loads to all the cards, but the

cards will continue to run on their existing loads. This option can be performed at any time.

@ Download Only ) Complete Upgrade

‘ Mext H Cancel |

* The second MG Upgrade Wizard step (step 2) allows the user to
specify All Card Types, one card type, or multiple card types. The
MG Upgrade Wizard will upgrade the software in all cards of the
selected type. The following figure shows the MG Upgrade Wizard,
Card Type Selection, Step 2.
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MG Upgrade Wizard, Step 2, card type selection, multiple cards

= MG Upgrade Wizard: ¥OIP10 1 =] E3
Card Type Selection: Step 2 of many.

[ All Applicable Card Types

A list of MG 9000 upgradeable card types is

provided. Check the card types to upgrade,

or check ‘All Applicable Card Types' to upgrade

all upgradeable card types in this MG 9000. [JITP Cards [JITX Cards

[[] Supercore OC3 Cards

| Previous H Next || Cancel ‘

The MG Upgrade Wizard contains a list of card types available to be
upgraded on the given MG 9000. One or more than one card types
can be selected for upgrade. The user can also select all the card

types on a given MG 9000 by selecting All Card Types. This panel
will enable or disable the check boxes for MTA and xDSL card types
based on the user’s selection in the Upgrade Type Selection Type,
Step 1.

e The next MG Upgrade Wizard (step 3) allows the user to enter a
load server IP address, a userid and password to be used to access
the load server. The last six entries for the server IP address are
remembered. The user can select between the last six entries or
enter a new one. A user is not allowed to move to the next panel until
all the entries on this panel are completed with valid data. The
following figure shows the MG Upgrade Wizard, Step 3.
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MG Upgrade Wizard, Step 3, select a load server

= MG Upgrade Wizard: ¥OIP10 1 H=] E3
Select a load server for selected cards: Step 3 of 4

Flease enter a new load server address or select from existing addresses. Also,
specify a user identifier and passward for the selected senver.

Server Address: 47 142,85 50 ﬂ

Server User ldentifier: | |

Server Pagsword: | |

| Remove Entries || Previous || Mext || Cancel |

When the load server panel is completed and Next is pressed, the
Load Information panel is displayed. It provides the directory and
load name. If only one card type is selected in the card type
selection panel this is the last panel in the wizard. The Finish button
is enabled. The user Interaction panel is not provided in the MG
Upgrade Wizard because the multi card type upgrade only supports
upgrades without user interaction. When Finish is selected, the load
name is checked for a valid version range. When the check passes,
the wizard is removed and the user is prompted to start the upgrade
for the selected card type.

If more than one card type is selected, or all card types are selected,
an additional Load Information panel is added to the wizard for each
card type selected. For example, if all card types are selected the
second panel is the Load server panel as in the previous case,
followed by the Load Information panel for ABI (if installed), followed
by the Load Information panel for DS1 (if installed), then ITP, then
ITX, and finally OC3 (or DS1-IMA). When the Specify a Load panel
for the last card type is completed Finish is pressed from the ABI
Specify a Load panel. The load names entered for the selected card
types are checked for version range validity after the Next button is
pressed on each card type configuration panel. (See Upgrade
version rules on page 74.) After the load is validated, the wizard is
removed and the user is prompted to start the upgrade.

* The next MG Upgrade Wizard step (step 4) allows the user to enter
the directory and load name to be used for the upgrade. Like the
Card Upgrade Wizard discussed earlier, if the entered directory is
incorrect, a message appears to inform the user and the directory
must be corrected for the upgrade to proceed.

NN10048-461 (I)SNO8 Standard 07.02 June 2005



Copyright © 2005

, Nortel Networks 97 Nortel Networks Confidential

The following figure shows the MG Upgrade Wizard, Step 3, Specify
a Load.

MG Upgrade Wizard, Step 4, Specify a load

~| MG Upgrade Wizard: gsf_col9 19 | 2 |_||
Specify a load for DS1: Step 4 of 7
Please specify a software load directory and load name
Directory: |fswdfmg9k | V| List
DS1 Load Name: | DS1G07BY_GZ |
| Remaove Entries | | Previous | | Mext | | Cancel |

Click on the List button to retrieve the files from the load server and
the combo box is populated with 9PI file names (identified by the .tar
extension on the filename). Choose a file from the list.

This step will continue to increment until the loads are specified for
each card type that is part of the upgrade. When the load for last
card in the upgrade is specified, click Finish.

When the configuration steps are completed, the MG Upgrade
Wizard is closed and the third pane in the Software Upgrade view is
modified to display the upgrade data for all the card types selected
for upgrade. The Software Upgrade View is shown in Software
upgrade accessed from Frame View on page 75 with a multiple card
types upgrade running. The MG 9000 can only upgrade one card
type at a time, so the MG 9000 Manager automatically schedules
the upgrade for the selected card types in sequence. The third pane
contains the card type for which the upgrade is in progress in the
MG 9000.

The third pane also contains a tabbed panel with a tab for each card
type selected for upgrade. Each tabbed entry contains the load
server, the user identifier, and the full path load name for that card
type. The card type being upgraded is on the top of the tabbed pane.

The following limitations apply to upgrading MTA and xDSL cards:

If the prepatched image contained an obsolete patch, NPM does not
remove the patch. An NPM alarm indicating that there is an obsolete
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patch is raised and the customer can see the obsolete patch in the
postcheck.

Prior to upgrading MTA or xDSL cards, the MG 9000 Manager
verifies that all the cards are in an unlocked/enabled state. If any
card is not in the correct state, the MG 9000 Manager will not
perform the upgrade.

To upgrade MTA and xDSL cards, the MG 9000 Manager will lock
the card, download the load to the card, and then unlock the card.
The order in which the MG 9000 Manager upgrades xDSL cards
cannot be specified as part of the upgrade.

The lock request of an XDSL card will fail if the card has an active
call. If the lock request fails for a given xDSL card, the MG 9000
Manager will note the failure and attempt to upgrade the remaining
xDSL cards. Once the MG 9000 Manager has upgraded the
remaining xDSL cards, the MG 9000 Manager will halt the upgrade
process. The MG 9000 Manager will report that some of the xDSL
cards could not be upgraded.

If the download or unlock of any MTA or xDSL card fails, the MG
9000 Manager immediately halts the upgrade process.

If an MTA or xDSL card already has the load file specified in the
upgrade request, the MG 9000 Manager will consider the card
already upgraded and move on to the next card to upgrade.

When upgrading xDSL cards, the MG 9000 Manager can upgrade
only those cards with supported hardware. If a given xDSL card
does not have a CLEI code of VATAAAAAA, the MG 9000 Manager
will skip that card and move on to the next card to upgrade.

If the user aborts an upgrade while the MG 9000 Manager is
upgrading the xDSL cards, the MG 9000 Manager will return all
cards to an unlocked state. However, the MG 9000 Manager will not
roll back the loads on any of the cards. For instance, assume the
user is upgrading all five xDSL cards on a given node. Assume the
user aborts the upgrade after the first two cards have upgraded and
a third card is in the process of upgrading. The MG 9000 Manager
halts the upgrade process after the third card completes its upgrade.
In the end, three xDSL cards are running the new load and two
xDSL cards are running the old load.

When a user begins the upgrade, the MG 9000 Manager will stop the
database. The database will not restart until the upgrade process
completes.
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Card upgrade with user intervention

When to use this procedure

Use this procedure when it is necessary to upgrade a single card or a
protection group in an MG 9000. This procedure provides the steps to
perform a software upgrade in a DCC, ITP, ITX, ABI, or DS1 card with
user interaction.

Prerequisites

Clear all alarms on the card to be upgraded before proceeding with the
upgrade process.

Action

Card upgrade with user intervention

At the MG 9000 Manager

1 From the Subnet View, select the network element (NE)
containing the card to be upgraded. Double click on the NE icon
and the Frame View appears.

2 Double click on the shelf containing the card and the Shelf View
appears.

3 Double click on the card to be upgraded and the Card View
appears.

4 If performing a single card upgrade, from the Card View of the

card selected for upgrade, lock the card by changing the
Administrative state to Lock from the Administrative state
pull-down menu.

5 From the Card View of the card selected for upgrade, select
Actions->Software Upgrade from the menu bar.

6 The Software Upgrade view appears as described in Software
Upgrade View on page 75.

There are four possible messages in the Card Upgrade View at
the time it appears:

* |f a previous user closed the view before an abort was
completed, the abort may still be in progress. An indication to
wait until the abort is completed is displayed. In this case, the
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Configure button is disabled. Either wait for the abort to
complete or close the view.

A message will appear notifying when the abort is
completed, and the Configure button is enabled.

Another user is performing an upgrade on a card on the
same MG 9000. In this case, the user can close the view or
abort the upgrade in process and start a new upgrade.

If no upgrade activity is in progress on the selected MG 9000,
the user is prompted to press the Configure button to start
the upgrade.

If the floating IP address has not been provisioned, the
system prompts you to provision it. After the floating IP
address is provisioned, continue with the procedure.

Press the Configure button to start the Upgrade wizard. The
upgrade wizard is created as described in Upgrade Wizard
overview on page 88.

Enter the parameters in the first three panels as described in
Upgrade Wizard overview on page 88.

Select “Perform Upgrade with user interaction” in the last panel.
Press Finish to completed the configuration. The user is
returned to the Card Upgrade View. The following figure shows
the Upgrade View with the system prompting the user to press
the Download button.
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Software Upgrade View

EPress Configure t
1|1 10r press Version List to see all the versions of the cards.
i EOr press History to see the results of previous upgrades.
i EODn’figurat'ion Completed.

IEP'resS Download Button to start upgrade with user interaction.

10 Press Download to request the MG 9000 to perform the
download step. When the download is complete, the results are
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11

12
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displayed in the result area of the Software Upgrade View as
follows:

* The download step was successful. The step button changes
to Apply. The user is prompted to perform the Apply step

* The download step failed. An indication of the failure is
indicated. Possible cause of failure could be:

— communication problems between the GUI client and the
mid-tier layer, between the mid tier layer and the MG 9000
Manager, between the MG 9000 Manager and the
MG 9000.

— invalid configuration parameters. The user could abort
the upgrade. When the upgrade is aborted, the step
button changes back to Upgrade.

Press the Apply button for the MG 9000 to perform the apply
step. When the apply is completed the results are displayed in
the result area of the card upgrade view as follows:

* The Apply step was successful. The step button changes to
Accept. Go to step 12.

e The Apply step failed. An indication of the failure is indicated.
Possible cause of failure could be:

— communication problems between the GUI client and the
mid-tier layer, between the mid tier layer and the MG 9000
Manager, between the MG 9000 Manager and the
MG 9000. The user must abort the upgrade. After that it
could configure again or close.

— card is locked (during protection group upgrade) or
involved in a maintenance activity. The system prompts to
unlock or wait until the maintenance activity is completed.
Press Apply again.

Press Accept to complete the upgrade. The Accept and Abort
buttons are disabled. When the Apply is completed, the results
are displayed in the result area of the card upgrade view as
follows:

* The accept step was successful. Close the Upgrade View.

* The accept step failed. An indication of the failure is
indicated. Possible cause of failure could be communication
problems between the MG 9000 Manager client and the
mid-tier server, between the mid-tier server and the master
server, between the master server and the MG 9000. Abort
the upgrade. Abort the upgrade by pressing the Abort button
to cancel the remainder of the upgrade.Configure again or
close.
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13

14

When the accept is completed, close the upgrade view. Apply
patches. Refer to “Applying patches using the NPM GU/I”
procedure in Upgrading a Carrier Voice over IP Networks,
NN10440-450 for patching procedures.

This procedure is complete.
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Card upgrade without user intervention

When to use this procedure

Use this procedure when it is necessary to upgrade the software in a
single card without user intervention. This procedure provides the steps
to perform a software upgrade in a single DCC, ITP, ITX, ABI, or DS1
card without user interaction.

Note: This procedure applies to single card upgrades only, not
multiple card upgrades.

Prerequisites

Clear all alarms on the card to be upgraded before proceeding with the
upgrade process.

Action

Card upgrade without user intervention

At the MG 9000 Manager

1 From the Subnet View, select the network element (NE)
containing the card to be upgraded. Double click on the NE icon
and the NE desktop view with Frame View appears.

2 Double click on the shelf containing the card and the Shelf View
appears.

3 Double click on the card to be upgraded and the Card View
appears.

4 If performing a single card upgrade, from the Card View of the

card selected for upgrade, lock the card by changing the
Administrative state to Lock from the Administrative state
pull-down menu.

5 From the Card View of the card selected for upgrade, select
Actions->Software Upgrade from the menu bar

6 The Software Upgrade view appears as described in Software
Upgrade View on page 75. The Software Upgrade View appears
as shown next.
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Software Upgrade View

£ MG 9000 Software Upgrade Element: 1 Hi=] E3
hAGE000

Upgrade Originator

MG 9000 Name:  colg 1 I

Originating “iew: i-r;d_é-Q_Dl_J_E-l-Element 1 |

Upgrade State:

Upgrade Status: iWaiting for Configure.

Upgrade Action: |Conﬂgure

Upgrade Type: |

Upgrade Type Data:

Upgrading: | |

Load Semwer. | |

Load Server User ld: | |

Load: | |

~Upgrade Instructions & Results:
Press Configure to invoke the Upgrade Configuration Wizard.
Or press Version List to see all the versions of the cards.
Or prass History to see the results of previous upgrades.

| History | | Refresh | | Configure | | “ersian List | | Abio I | Close |

There are four possible messages in the Software Upgrade View
at the time it appears:

* |f a previous user closed the view before an abort was
completed, the abort may still be in progress. An indication to
wait until the abort is completed is displayed. In this case, the
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10

Configure button is disabled. Either wait for the abort to
complete or close the view.

A message appears notifying when the abort is complete,
and the Configure button is enabled.

* Another user is performing an upgrade on a card on the
same MG 9000. In this case, the user can close the view or
abort the upgrade in process and start a new upgrade.

* Ifnoupgrade activity is in progress on the selected MG 9000,
the user is prompted to press the Configure button to start
the upgrade.

e Select Upgrade to continue with the upgrade without user
interaction. If the floating IP address has not been
provisioned the user is prompted to provision it. After that,
continue with the upgrade procedure.

Press the Configure button to start the Upgrade wizard. The
Card Upgrade Wizard appears. See Upgrade Wizard overview
on page 88.

Enter the parameters in the first three panels as described in
Upgrade Wizard overview on page 88.

Select “Perform Upgrade without user interaction” in the last
panel. Press Finish to complete the configuration.

Messages indicating the progress of the upgrade, download,
apply, and accept steps are displayed. If a step fails, a message
is displayed indicating the reason. The user can abort and
perform the configure step again or close the view.

The download icon appears in the Shelf View and the Card View.
The icon remains until the upgrade is completed or aborted.
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Shelf View and Card View with download icon
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When the accept is completed, close the upgrade view. Apply

patches. Refer to “Applying patches using the NPM GU/I”
procedure in Upgrading a Carrier Voice over IP Networks,
NN10440-450 for patching procedures.

12

If problems occur, abort the upgrade by pressing the Abort

button to cancel the remainder of the upgrade.

13 This procedure is complete.
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MG upgrades

When to use this procedure
Use the following procedure when it is necessary to upgrade the
software in multiple cards and protection groups without user
intervention. This procedure provides the steps to perform a software
upgrade in DCC, ITP, ITX, ABI, and DS1 cards without user interaction.

Prerequisites

Clear all alarms on the cards to be upgraded before proceeding with the
upgrade process.

Action

MG upgrades

At the SN06.x MG 9000 Manager

1 At the Frame View of the MG 9000 selected for upgrade click the
Actions menu.

2 At the Actions menu select Software Upgrade... The MG 9000
Software Upgrade view is created as described in Software
Upgrade View on page 75

3 Check the Upgrade Originator pane in the MG 9000 Software
Upgrade View to ensure the MG 9000 Name and Originating
View (NE number) represent the MG 9000 to be upgraded.

4 Press the Configure button to start the MG Upgrade wizard. The
Upgrade Type Selection, Step 1 appears. Choose “Complete
Upgrade.” Next, the MG Upgrade Wizard, Card Type Selection,
Step 2 appears.

5 Select the card types to upgrade or select all card types by
selecting All Applicable Card Types. A check appears in the
appropriate box next to the selection.
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6 Enter the load server information. Use the following table to
determine the next step.
If upgrading Do
only one card type step 7
multiple card types step 8

7 In the MG Upgrade Wizard, Specify a load, specify the load
directory and load name. The upgrade now begins. Go to step 9.

8 In the MG Upgrade Wizard, Specify a load, specify the load
directory and load name for the card type (such as,
SCOA08AZ_GZ.tar). The system repeats this step in succession
for each card type in the following order: DS1, ABI, ITP, ITX, and
DCC. The load names are checked for version range validity.

The MG Upgrade Wizard closes, the MG 9000 Software
Upgrade View appears with the Upgrade Type Data panel
updated to display the upgrade data for all the card types
selected for upgrade and reports the card type for which the
upgrade is in progress in the MG 9000. Go to step 9.

Note: The MG 9000 upgrades one card type at a time. The
MG 9000 Manager schedules the upgrade for the selected
card types in sequence.

9 This procedure is complete.

i ]
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Downloading software into the MTA card

When to use this procedure

Use this procedure when it is necessary to update software onto an
MTA card. The Software Download Manager menu option provides
access to a Software Download Manager window.

Prerequisites
None

Action

Downloading software into the MTA card

At the MG 9000 Manager

1 At the Subnet View, double click on the MG 9000 that has the
MTA card to which software is to be downloaded. The Frame
View appears.

2 At the Frame View, double click on the shelf in which the MTA
card resides. The Shelf View appears.

3 At the Shelf View, double click on the slot in which the MTA card
resides. The card view appears.

4 To request a download, select the Locked option for the
Administrative Status in the Status box. The card must be
Locked prior to requesting a download.

5 From the MTA Card View menu level, select Actions->Software
Download Manager

6 Enter data in the fields as follows:

* File Path - the path and name of the file on the load server to
be downloaded to the card (/mg9k/<loadname>)

e |P address - the file location (IP address)

* Server userName - the login name for the server where load
resides

e Server password - the password for the server where load
resides

* select Force Download if forced download is required. The
Force option is needed only when the card must be reloaded
with the same load that already exists on the card.

7 Select the Download button at the bottom of the Software
Download Manager window.
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Once the download is complete, the Load Status field indicates
if the download was successful, and the software load being
used by the card is displayed under Restart Current in the
Software Load pane.

Note: After the software download is performed, a message
appears stating that the MTA card is restarted.

Perform the download again, since the MTA card has a Primary
and Backup load. When a download is performed, the Primary
load becomes the Backup load and the new load becomes the
Primary load. Performing the download twice makes the new
load the Primary and the Backup load and guarantees the
current load is the new load.

8 After the second download is complete, from the MTA Card View
set the Administrative Status of the MTA card to Unlocked by
selecting the Unlocked option in the Status box.

9 This procedure is complete. If this action is part of an MG 9000
upgrade, return to the upgrade checklist to continue with the
upgrade process.
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Downloading software into the xDSL card

When to use this procedure

Use this procedure when it is necessary to download updated software
onto an xDSL card. The Software Download Manager menu option
provides access to a Software Download Manager window.

Prerequisites
Perform this activity during periods of low traffic.

Action

Downloading software into the xDSL card

At the MG 9000 Manager

1 At the Subnet View, double click on the MG 9000 that has the
xDSL card to which software is to be downloaded. The Frame
View appears.

2 At the Frame View, double click on the shelf in which the xDSL
card resides. The Shelf View appears.

3 At the Shelf View, double click on the slot in which the xDSL card
resides. The card view appears.

4 To request a download, select the Locked option for the
Administrative Status in the Status box. The card must be
Locked prior to requesting a download.

5 From the xDSL Card View menu level, select Actions->Software
Download Manager

6 Enter data in the fields as follows:

* File Path - the path and name of the file to be downloaded to
the card (/mg9k/<loadname>)

Note: In certain offices, the file path may be /swd/mg9k/

e |P address - the file location (IP address)

* Server userName - the login name for the server where load
resides

e Server password - the password for the server where load
resides

* select Force Download if forced download is required. The
force option is needed only when the card must be reloaded
with the same load that already exists on the card.
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7

Select the Download button at the bottom of the Software
Download Manager window. When the download begins the
download icon appears on the card.

Once the download is complete, the download icon disappears
and the initialization icon appears. Once initialization is

complete, the icon disappears and the software load used in the
card is displayed in the Software Load section of the Card View.

If necessary, repeat steps 3 through 7 for all xDSL cards in the
MG 9000 network element that must be upgraded. Otherwise
skip this step.

Unlock the card that was locked in step 4.

This procedure is complete. If this action is part of an MG 9000
upgrade, return to the upgrade checklist to continue with the
upgrade process.
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Upgrade history

NN10048-461

The Upgrade History is a view that is accessed from the Software
Upgrade View that reads information about upgrades performed on an
MG 9000. The Upgrade History contains:

* the time the upgrade was performed
* the type of upgrade

* the card the upgrade was performed
* the full path of the load name

e the final status

All the entries status is completed or aborted. The last entry may have
a different status since an upgrade is in progress.

An entry is created in the Upgrade History when the user attempts to
image a card.

The Software Upgrade History windows shows the following message
at the bottom of the window: Upgrade history is not maintained for any
MTA and xDSL cards that may be present in the NE.

The following buttons are provided in the Upgrade History:

* Delete - used to delete a history entry. An attempt to delete an entry
for an upgrade in progress will fail.

* Refresh - used to update the view with the latest data since the view
is not dynamically updated.

e Close - used to exit the Upgrade History view.

From the menu bar, the following MG9000 items are available
* Close - used to exit the Upgrade History view

* Reset Upgrade System - used to reset the upgrade system back to
idle (that is, the upgrade process is abandoned where it is). This
action could leave the cards in a mixed state, and the loads in the
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cards will not be reverted back to the original loads. Clear the card
fault or replace the faulty card and try the upgrade again.

The following figure shows the Reset Upgrade System command.

Reset Upgrade System command

Software History: MG16 16 -
MG3000 |

Close Type Target Load Mame Status |

Reset UpgradeSystem

The Reset Upgrade System command requires emsadm
permission and is considered a drastic step. Do not use this
command unless directed to do so by Nortel Networks customer
support.

The following figure shows the warning message that appears when
the Reset Upgrade System command is used.

Reset Upgrade System command warning

Wiiarning

ARMING! This command will halt and reset the upgrade system.
Unpredictable results will occur if used during a normal upgrade.
Contact Mortel Custorner Support Personnel before using this comrmand.
Do you want to continue to reset the upgrade system?

YES MO

The following figure shows the History View.
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Software upgrade History View

= Software Upgrade History: PL6 1 AN

hiz8000

Upgrade Time | Upgrade Tyne | Unpgrade Target | Load Kame | Upgrade Status
Thu Jan 01 02:34:01 EST ... (Single Hode ME Number: 1 NE Name: PLG PhysLoc 0111 | frinebimg8hlo ads/OG3uemg_17/0C3A... (Upgrade completed suscesst..
Thu Jan 07 01:48:30 EST ... |Single Hode NE Number: 1 NE Name: PLG PhysLoc: 0121 |friebimgSlflo ads/ D51 uemg_17/0516... Upgrade aborted,
Thu Jan 01 01:09:48 EST ... |Single Hode NE Number. 1 NE Mame: PLG PhysLoc: 0112 |friwebimgdhflo ads/ TPuemg_17HTPADY. . |Upgrade completed suscesst...
Thu Jan 01 02:40:05 EST ... |Single Node NE Number: 1 NE Name: PLG PhysLoc: 0121 |frinebmg8hkfloads/D5 1 uemg_17i0516G... |Upgrade aborted.
Thu Jan 01 02:02:42 EST ... [Single Hode NE Humber: 1 NE Mame: PLG PhysLoc: 0115 ftrinebimgdkiloads TXuemg_17/1TRAD4... |Upgrade completed sus cesst...
Thu Jan 01 00:30:19 EST ... |Single Hode NE Number: 1 NE Name: PLE PhysLoc: 0112 trinebimgSkiloads! TRAvemg_17/TPAD4... Upgrade aborted.
Thu Jan 01 01:13:04 EST ... |Single Node NE Number: 1 NE Name: PLS PhysLoc 0121 |ftrimebimg8hloadsD S uemg_17/051G... (Upgrade aborted.
Thu Jan 01 01:18:36 EST ... |Single Node NE Humbar: 1 NE Mame: PLE PhysLoc: 0121 |ftriweb/mg3kiloadsiD S uemg_17/0516... Upgrade aborted.
ThuJan 01 00:48:52 EST ... |Single Hode NE Number: 1 NE Name: PLE PhysLoc: 0112 ftriweb/mgdkiloads! TRiuemg_17ATPAD4... Upgrade aborted.

Delete Refresh Close

NN10048-461 (I)SNO8 Standard 07.02 June 2005



Copyright © 2005, Nortel Networks 117 Nortel Networks Confidential

Patching the MG 9000

The MG 9000 is patched using the Network Patching Manager (NPM)
patching system. Any device to be patched must first be audited to
determine the load name compatibility with the patch before applying
the patch.

For information and procedures for patching the MG 9000 software
using the NPM, refer to the Succession Patching chapter in Upgrading
a Carrier Voice over IP Network, NN10440-450.

Upgrading the MG 9000
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